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Make sure to read the safety precautions indicated in this guide.
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The user is cautioned that unauthorized changes or modifications not
approved could void the user's authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instruction manual, may
cause harmful interference to radio communications. Operation of this
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Warning
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measures.

Perchlorate Material-special handling may apply,
See www.dtsc.ca.gov/hazardouswaste/perchlorate

This product may contain certain substances which are restricted when
disposed.
Therefore, be sure to consult your contracted service dealer.
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Thank you for purchasing this machine.
This machine is a digital screen maker that can be easily operated.

This guide contains instructions for basic operation of the machine, precautions
on use, methods for handling consumables, and a troubleshooting guide.

Carefully read this guide before using the machine. Also read this guide if you
have any question during use and whenever it is necessary, and make use of it
with the machine for many years to come.

* Microsoft and Windows are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

e Mac and Mac OS are trademarks of Apple Inc.

. O &lS‘. GOCCOPRO, and RISORINC are trademarks or registered
trademarks of RISO KAGAKU CORPORATION in the United States and other
countries.

e All other product names and company names are registered trademarks or
trademarks of each company, respectively.

e The screens and content appearing in this guide may differ from the actual
product.

e The screens and messages appearing in procedures may differ depending
on the type of the computer and the application (this guide uses screens of
Windows 7).

© Copyright 2020 RISO KAGAKU CORPORATION



The Notation in This Guide

The notation, marks, and terminology used in this guide are indicated below.

Notation of Pages Containing Descriptions of Operations and

Functions

Pages containing descriptions of functions and operations use the following notation. Also, the names of
hard keys on the operation panel and buttons on the computer window are indicated with square brackets

[].

Preparing the Ma @

ISetling the Screen
Frame

@ mportant

1] Settings in the Custom Setting Mode »
P58

1 Push up the Screen Making U/Open
Lever and open the Screen/Aaking Uit

(O Chapter title

@ Operating procedure

Marks Used in This Guide

/N\ Warning

/\ Caution

A caution related to safety.
For details, see “Warning
indications” on page 12 of
this guide.

@ 'mportant

An important point to note
when operating the ma-
chine.

=4

NOTE

Supplementary information
that is convenient to know
when using the machine.

Indicates a related refer-
ence page.

An operating procedure is de-
scribed in steps.

3 Operation illustration

Shows a part related to the op-
eration such as the machine,
Control Panel, or a computer
display.

Terminology Used in This
Guide

Image and text data created

Original data
on a computer.

The process for reading orig-
inal data sent from a comput-
er on the machine and perfo-
rating a screen master.

The initial value of each set-
ting immediately after the
power switch of the machine
is turned on.

Screen making

Default value

Note Regarding Computer
Screens

The way dialog boxes, etc. are displayed may
differ to the way indicated in this guide, depend-
ing on the version of the operating system used
in your computer.
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| 1. Introduction

Safety Precautions

This section describes the information that you need to be aware of before using this machine.

Read this section before operating this machine.

IWarning Indications

The following warning indications are used to
ensure proper operation of this machine and
also to prevent hazards to the human body and
damage to property.

Ensure the content is understood clearly before
proceeding to the main text.

Indicates that incorrect
handling by ignoring
AWarning this symbol may cause

death or serious human
injury.

Indicates that incorrect
handling by ignoring
&Caution this symbol may cause

human injury or dam-
age to properties.

I Installation Location

/\ Caution

* Do not place this machine on an unstable
location, such as a wobbly base or tilted sur-
face. If this machine falls down or falls over,
the situation may result in injury.

* Keep this machine away from humid and
dusty environments. Failure to do so may
result in fire or electric shock.

* This machine is not suitable for use by chil-
dren. Use the machine in a location not ac-
cessible by children.

I Power Connection

/N\ Warning

* The provided power cord is dedicated for
this machine. Do not use it for other electrical
products. It may result in fire or electric shock.

* Do not use the power cable tied up or coiled to
avoid the cable heating up and causing a fire.

12

/\ Warning

* Do not use a branching out-

let or multiple outlet extension
plug. It may result in fire or

electric shock.

e Do not scratch, damage, or
process the power cord. Do not %
damage the power cord by plac-
ing heavy objects on it or pulling

or forcibly bending it. It may re-
sult in fire or electric shock.

* Do not plug or unplug the power cord with
wet hands. It may result in electric shock.

/\ Caution

e When unplugging, do not pull the power
cord (be sure to hold the plug). It could dam-
age the cord, and this may result in fire or
electric shock.

e If this machine is not used for a long time
due to consecutive holidays, etc., be sure to
unplug the power cord to ensure safety.

* Unplug the power cord at least once a year
and clean the prongs of the plug and their
surroundings. Dust collected on these areas
may result in fire.

I Ground Connection

/N\ Warning

* Be sure to insert the power plug
with a ground conductor into
the wall outlet with a ground re-
ceptacle. If the machine is not
grounded, a short circuit may oc-
cur. It may result in fire or electric
shock.
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IMachine Handling

/N\ Warning

* Do not place a container that is filled with
water or metallic objects on this machine. If
the water spills or the water or metallic ob-
jects fall into this machine, it may result in
fire or electric shock.

* Do not use combustible spray and flamma-
ble solvent near this machine. If the sprayed
gas or flammable solvent contacts the elec-
trical parts inside the mechanical system, it
may result in fire or electric shock.

* Do not insert or drop foreign matter, such
as metallic parts or highly combustible mat-
ter, into this machine through any opening. It
may result in fire or electric shock.

¢ Do not remove the covers of this machine.
Removing the covers may result in electric
shock.

* Do not disassemble or modify @
this machine. It may result in
fire or electric shock.

* The thermal head and sur-

rounding metal parts are hot
while the power is on, or just
after the power is switched off.
Do not touch it to avoid burn-
ing yourself. When cleaning
the machine, wait until it has
cooled down.

* Do not let someone who does not know how
to use the machine touch it. It may cause an
unexpected accident by touching danger-
ous parts or by starting the machine unin-
tentionally.

e If this machine emits exces-
sive heat, smoke or foul odor,
immediately turn off the pow-
er switch, unplug the power
cord, and consult your dealer
or authorized service repre-
sentative. Failure to do so may
result in fire or electric shock.
For more information, consult
your dealer or authorized ser-
vice representative.

/N\ Warning

* If foreign matter enters this ma-
chine, immediately turn off the
power switch of the main unit,
unplug the power cord and con-
sult your dealer or authorized
service representative. If you
continue to use this machine
without taking appropriate mea-
sures, it may result in fire or
electric shock.

/\ Caution

* Never put your finger into an opening, etc. of
this machine. It may result in injury.

e [f lifting or moving the machine, be sure to
hold the bottom of the main unit. Holding the
upper part of the main unit may cause it to
fall and result in injury.

* The machine weighs approximately 71 kg (157 Ib).
Take adequate precautions when packaging, in-
stalling, and moving the machine.

Do not get your hands or
arms caught

The warning label in-
dicates the possibility
of injury caused by
your hand or arm get-
ting caught in a cover
or insertion slot, etc.

® Do not insert your hands or allow your cloth-
ing to get caught when the Screen Making
Unit is moving. It may result in injury.
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I Caution Label

For safety use, the caution label below is adhered to this unit. When operating or maintaining this unit, read
the instructions on the caution labels for safe use.

Do not remove or dirty the label. If the label is not stuck on the unit, turned out or unreadable, contact your
dealer or authorized service representative.

Location of the Caution Label

The locations of the caution labels (warning) are shown below.

Front/Bottom side

Thermal Print Head Caution Label

Since the Thermal Print
Head is very delicate,
avoid shocks or
scratches with a hard
object.

118-28060-009

Rear/Top side

Warning Label

118-28059-000

Content of the Thermal Print Head Caution Label

The location indicated by this label (Thermal Print Head) is at a high temperature. Since the Thermal Print
Head is very delicate, avoid shocks or scratches with a hard object.

Content of Warning Label

The warning label indicates the possibility of injury caused by getting your hand or arm caught while the
Screen Making Unit is moving.

14
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Before Starting Use

. ® The appropriate environment
I PrecaUtl.ons for conditions are as follows.
Installation « Temperature range:
15°C to 30 °C
Installation location (59°F 1o 86 °F)

® The installation location of this machine will
be determined in consultation with you during
delivery.

e Humidity range:
40 % to 70 %
(no condensation)

® The installation location of the machine
should be fixed. When you want to move this
machine, consult your dealer or authorized .
service representative. Required Space

® Do not install this machine in the locations
listed below. Failure to observe this precau-
tion may result in malfunction, failure, or acci- Units: mm (inch)
dent. :

* Locations with exposure to
direct sunlight and locations
close to windows (cover :
the windows with curtains if 1230 (48.43)
necessary) :

This machine requires the following space.

* Locations that are subject to sudden chang-
es in temperature

* Extremely hot and humid locations or cold
and dry locations

* Locations exposed to fire or heat, direct (5.91)
cold air (e.g., air conditioner), direct hot air
(e.g., heater), or where heat is transmitted

¢ Locations with poor permeability and ven-
tilation

e Dusty places

* Locations without sufficient strength such
as work table

Notes on Operation
Environment

® Install the machine in a place whose level-
ness is within the following specified range.
(Levelness for installation: 10 mm (0.39") or
less both lengthwise and widthwise)

Adjuster Feet » P. 22
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| Precautions on

Connection

Precautions for Connecting
with the Power Supply

® Be sure to plug in the power
cord securely to prevent poor
contact in the power plug sec-
tion.

® | ocate this machine near the electric outlet.

The Printer Driver

This printer driver is designed for screen making
by transmitting original data from your computer.

The printer driver is contained in the included
CD-ROM. When making a screen master for
the first time, it is necessary to install the printer
driver.

Precautions on the
Connection with a
Computer

® Before using the machine, be sure to install
the printer driver from the included CD-ROM.

@ 'mportant

Do not connect the machine with the comput-
er before installing the printer driver.

® This machine must be connected with a com-
puter via a commercially available USB cable
(less than 3 m (10 feet), compliant with Hi-
Speed USB).

® The maximum allowable voltage for USB con-
nector input and output is 5 V.

| Precautions for Use

Handling

® The machine is a precision machine. Do not
place heavy objects on the machine or do not
apply a shock or excessive force to it.

® Do not insert your fingers or hands into the
thermal head part and movable parts.

® Do not move the Screen Making Unit with
your hands. Use the Custom Setting mode to
move the Screen Making Unit to the center.

® Do not turn off the power or unplug the power
cord during operation.

® While the machine is running, do not move a
screen frame and do not move the machine.

® Do not open the Screen Making Unit during
operation.

® This machine contains precision parts and
drive mechanisms. Perform only the proce-
dures described in this guide.

® Clean this machine frequently. If a foreign ma-
terial is on a screen, the thermal head will be
damaged. Do not use highly-soluble organic
solvents such as thinner and benzene for clean-
ing. If they are used, coating peeling and failures
will occur. For cleaning, use neutral detergent.

® For the machine, use the specified RISO
Digital Screen Master and RISO DIGITAL
SCREEN QS MASTER. If other screens are
used, the quality will not be guaranteed.

Screen Master > P. 78

Storing the Screen Master

Properly store the screen master. Do not store
those parts in the locations listed below.

* Locations with exposure to
direct sunlight and locations
close to windows (cover
the windows with curtains if
necessary)

* Locations that are subject to sudden chang-
es in temperature

e Extremely hot and humid locations or cold
and dry locations



1. Introduction

IMateriaIs not to be
printed

Do not use this machine in any manner which vi-
olates the laws or infringes on established copy-
rights, even when making copies for personal
use. Consult your local authorities for further
details. In general, use discretion and common
sense.
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| 1. Introduction

Features of this Machine

This machine is a digital screen maker exclusively designed for RISO Digital Screen Masters. Attach a screen to the screen
frame and set it on the machine to perform screen making. This guide describes the process until “3. Screen making”.

18

IProcess from Screen Making to Printing

dnies [eniu] °|

Buyew usealos Buuedald g

Install the “RISO GOCCOPRO Printer
Driver” to your computer.

i

(@)

I 1
IIIIuI]lILIg

Installation Procedure:
For Windows » P. 35
For Mac OS » P. 38

Set the screen frame on the machine.

Setting the Screen Frame P P. 30

Connect the machine to the computer
via a USB cable, and turn the power
switch of the machine on.

Connecting the Cable and Power Supply
» P 32

o

Buiyew ussiog

Bunuud v

Transmit the original data.

o W

Transmitting the Original Data:
For Windows » P. 42
For Mac OS » P. 50

(@)

| I||| ]

Screen making starts.

Screen making is complete.

Print with ink suitable for the material
and intended use.
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IOperatlon Checkpoints

# Registering the Screen Frame Size m

Set the screen frame to use in advance. ; You can check a preview of how the image will

be transferred onto the screen in [Preview] of the
— printer driver before performing screen making.
Width: 25.00 fnch~]

[23.23 - 25. o0

8

e j * |sthe image contained within the image area?
[12.20 - 36.00; B
B * Is the image orientation correct?

Screen frame size (frame width)

Z

Image area’}

=
(=]
j=
<
=

Screen Frame Size » P. 25

Registering the Screen Frame Size
(Windows) » P. 43

@ Setting the Printer Driver

Frame thickness >

Screen frame size (frame length)

> Frame thickness

The screening type can be specified ac-
cording to the image to transfer, the mate- :
rial to print on, and the ink to use. Details on the image area and image orien-
tation are described elsewhere in this guide.

7 :
- T ] Information on Screen Making P P. 25
B - - E— 5
§ - | Machine Fu nctionality
- m?:':m The machine enables fine text and gradations to
== = —1 be reproduced with a high precision via high-res-

olution perforation at 600 dpi (perforation density

Setting the Screen Frame Size 1200 dpi) x 1200 dpi.
(Windows) » P. 46 (Image)

Registering the Image Area
(Mac OS) » P. 51

Setting the Screen Making Process: »

For Windows » P. 46
For Mac OS » P. 54

Setting the Screening Type: 600 dpi 1200 dpi
For Windows » P. 48
For Mac OS » P. 55 : Special processing may be required, depending on the type
of medium.

19
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2. Overview of this Machine

Names of Parts

This section describes the names and functions of parts of the machine.

IMain Unit

Front/Bottom Side

(D Screen Making Unit

Contains the Thermal Print Head.

This unit moves above the screen frame in the
Top and Bottom directions to produce an imaged
screen from an image sent from a computer.

@ Screen Making Unit Open Lever
Lift up this lever to release the lock mecha-
nism when opening the Screen Making Unit.
(3 Stage
Slide this part to secure the Bottom side of the
screen frame.
@ Control Panel

Displays the status of the machine and is
used to perform operations such as changing
the settings of the machine.

Control Panel > P. 24

®

® Power Switch
Turns the power of the machine on and off.

@ 'mportant

When turning the power of the machine OFF
and then ON again, wait 10 seconds or more
before performing an operation.

® Stage Handle (x 2)
Turn this handle counterclockwise to make
the stage movable. Turn this handle clockwise
to secure the stage.

@ Adjuster Feet (x 4)
Rotate the bolts to adjust the levelness of the
machine.

Notes on Operation Environment » P. 15



2. Overview of this Machine

Rear/Top Side

@® @

Bottom Guide Pin

Position the Bottom side of the screen frame.

© Bottom Stopper Pin
Fasten the Bottom side of the screen frame.

Frame Bottom Set
This is used when moving the Stage.

@) Screen Frame Retainer (x 2)

Determines the position of the screen frame
(x 2 on the Top side).

Can be moved to a position of your choice
and fixed with the screws.

@ Screen Frame Side Guide (Front)

Secures the front side of the screen frame.
Includes 1 Screen Frame Retainer.

~“7 You can unscrew this guide, turn it over and
NoTE attach it on the rear side of the machine.
(This is convenient when installing the ma-
chine so that the Top side of the machine is
on your right side, according to the usage
environment.)
@ Screen Frame Top Guide
Secures the Top side of the screen frame.
Includes 2 Screen Frame Retainers.
USB Port

Used to connect a USB cable.

@ Power Connector
Used to connect the power cord.

23




2. Overview of this Machine

I Control Panel

S,

@

©

//RESET

STOP

®

©@

@ Display 2 DATA Indicator

24

Indicates the screen making status of the ma-
chine using 7 segment graphics.

(Example) During screen making

-*-
-<-

Also indicates setting values, the Custom
Setting mode, and error numbers.

Custom Setting Mode » P. 57

Troubleshooting » P. 67

The LED blinks or turns on to indicate the sta-
tus of the machine.

* Blinking: Receiving data
* On . Data reception complete

3 RESET Key

Press to return the Custom Setting Mode and
other settings to their default values or clear
errors.

@ STOP Key

Press during screen making to stop screen
making.

It also operates as the confirmation key when
entering setting values in the Custom Setting
Mode.

® START Key

Press to confirm settings in the Custom Set-
ting Mode or start an operation.



2. Overview of this Machine

Information on Screen Making

Make sure to read this section carefully in order to perform screen making in a safe and appropriate manner.

I Direction and Size of Screen Making
Image Orientation

The relationship between the orientation of the original data created on the computer and the orientation of
the image transferred onto a screen is as follows.

i ' Landscape

: Portrait
-

Dooooooo0 BN

Landscape

ooooooo00 Sk MR A

=43 I|—||—||—I—||—||J'| '_"_"_llg

Screen Frame Size

@ 'mportant

* Using a screen frame that exceeds the maximum size may cause the machine to malfunction.
* A screen frame that exceeds the maximum frame thickness cannot be used.

The following screen frame sizes can be used with the machine.

Frame Outer Dimensions Frame Thickness
Width Length Thickness Height
Minimum Size 590 mm (23.23") 310 mm (12.20") 20 mm (0.79") 20 mm (0.79")
Maximum Size 635 mm (25.00") 914 mm (36.00") 45 mm (1.77") 45 mm (1.77")

Q The “Width” of the frame outer dimensions indicates the width from the front side to the rear side of

NoTE the screen frame, and the “Length” indicates the length from the Top side to the Bottom side of the
screen frame.

Length:
310 mm to 914 mm (12.20" to 36.00")

3 T
E . .
& @ e Thickness:
coo i 20 mm to 45 mm
£ Top L (0.79"101.77")
ESNS :
S \
Ss o
S@d G0

Height:
20 mm to 45 mm
(0.79" t0 1.77")

25



2. Overview of this Machine

26

Screen Making Area
Screen Making Start Position

Screen making starts from the Top side of the screen frame.
The screen making start position is fixed to 90 mm (3.54") from the outer edge of the screen frame (and
cannot be changed).

Screen making start position @

4

Top

| :

90 mm (3.54")

Margin and Image Area

Always consider that there will be a margin between the screen frame and the transferred image.
The minimum margin size on the Bottom side, Front side, and Rear side is 45 mm (1.77") from the inside

of the screen frame.

The minimum size of the image area is 10 mm x 10 mm (0.39" x 0.39").
The maximum size can be calculated as follows.

90 mm (3.54")  45mm (1.77") ormore (. )
> > Minimum: 10 mm (0.39")
o ; ; :
E 1 i Maximum: Whichever of the following values is smallest
S} 457 mm (17.99")
~ Width :
™~ (B) Width of screen frame _ Screenframe 90 mm
= outer dimensions thickness x 2 (3.54")"
E --I- - | - — - - - *Minimum margin size x 2
0 KT '
N > f e N
Length (A) Minimum: 10 mm (0.39")

i Maximum: The following value

Length of screen frame  Screen frame 135 mm

outer dimensions thickness ~ (5.31")*

*Screen making start position + Minimum margin size




2. Overview of this Machine

I Image Size and
Orientation

If the image of the original data exceeds the
image area or screen frame size area, any part
outside the image area will not be transferred to
the screen. Change the zoom ratio of the image
when sending the original data to make it fit in-
side the image area.

Images Larger than the
Maximum Size of the Image
Area

Reduce the size of the image to make it fit inside
the image area.

45 mm (1.77") or more

G < — (B)

45 mm (1.77") or more

Margin and Image Area » P. 26

Extremely Wide Images

Rotate the image 90 degrees in the printer driver
to make it fit inside the image area.

Very wide image

Part of the image is
not transferred.

>
o
(@)
O

o

N\

e —— h
' ...... \\ .......

image - \%“:\

e T @

Rotate 90 degrees

==]

Fits inside area.
o

Image '

\\\N\\\\§

...........................

- J

Rotation/Mirror Image » P. 77
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2. Overview of this Machine

I Handling Original Data

Image Data with Multiple
Pages

If you transmit original data with multiple pages,
only the first page will be transferred onto the
screen. The second and subsequent pages are
not transferred and their data is not saved.

JOriginal data
including

/Lmultiple pages

First page: Second and subsequent pages:

Transferred
onto a screen

Not transferred
onto a screen

7 Only the first page is transferred for original
NoTe data that has accidentally overlapped onto
multiple pages. Make sure to check the
page layout when editing the original data.

JOriginal data
— overlapping onto
4] /Lmultiple pages

d -

First page: Second and subsequent pages:
Transferred Not transferred
onto a screen onto a screen

Timing for Data
Transmission

Make sure that the previous screen making op-
eration is complete and a new screen frame has
When transferring multiple pages, divide the been set before transmitting the original data.
original data into pages with separate file names

If you transmit the next original data durin
and perform screen making for each file. y 9 9

; screen making, it will not be transferred and the
original data will not be saved.
fOriginal data :

including
® /Lmultiple pages

ﬂ»ﬂ%ﬂ

Divide into separate
One file files per page

28



2. Overview of this Machine

ITips for Smooth Screen
Making

Screen Frame Side Guide
Installation

The exterior of the machine on the Top side has
a scale to enable the Screen Frame Side Guide
to be quickly and easily installed.

Align the reference mark of the Screen Frame
Side Guide with this scale according to the size
of the screen frame that will be used.

Position of scale (from outside)
v 635 mm (25.00")
v 610 mm (24.00")
v 584 mm (23.00")

Screen Master Tension

Various problems may occur if the tension of the
screen master attached to the screen frame is
too loose, such as misalignment in image trans-
fer or blurry images.

Although the control value varies according to
the screen size, in general an appropriate re-
sult can be obtained if the tension of the screen
masteris 11 £ 1 N/cm'.

*This is not a recommended value for obtaining
an optimal print result.

11 =1 N/cm
\ J//
/ \
\ ]
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2. Overview of this Machine

Preparing the Machine

I Settlng the Screen 1 Push up the Screen Making Unit Open
Frame Lever and open the Screen Making Unit.

/\ Caution

* When holding the screen frame, hold it care-
fully with both hands to ensure that it does
not hit the machine or drop onto the floor.

* Take care to ensure that the screen frame
does not touch the Thermal Print Head.

@ 'mportant
2 Loosen the Stage Handle to make the

Stage movable.

e Set the screen frame in the center of the
machine. Insufficient centering may cause
misalignment during image transfer.

Attach a mark in the center of the screen
frame in advance.

3 Move the Screen Frame Side Guide
toward yourself.

* It is necessary to change the heat level of
the Thermal Print Head according to the
mesh count of the Screen Master being
used.

Check Custom Setting Mode No. 017
[Screen Making Energy Variables] for de-
tails.

Settings in the Custom Setting Mode »

P.58
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2. Overview of this Machine

4 Place the screen frame with screen

5

master attached against the 2 Screen
Frame Retainers and Screen Frame Side
Guide.

@ 'mportant

In order to stabilize the screen frame, set the
Screen Frame Retainer on the wide side.

R Y A

OK Not OK

Screen Frame Retainer » P. 23

Adjust the Screen Frame Side Guide
so that the mark on the screen frame
is aligned with the arrow on the Screen
Frame Top Guide.

Secure the Screen Frame Side Guide.

Move the Stage while holding down the
screen frame and place the Bottom Guide
Pin firmly against the Bottom side of the
screen frame.

While pressing the Frame Bottom Set in
the direction of the screen frame, tighten
the Stage Handle (x 2).

@ 'mportant

» Fasten the stage with the Bottom
Stopper Pin in contact with the screen
frame.

* The Stage may move during operation
if the Stage Handle is loose. Make sure
to tighten the Stage Handle securely.

* The Stage Handle on the Rear side
must be turned more than that on the
Front side.

~“7 If the handle is located on the Control
NoTe Panel and blocks screen making op-
erations, it can be pulled up and ad-
justed to a lock position of your choice.
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2. Overview of this Machine

9 Check that the screen frame is in contact I Con neCtlng the Cable
with the Screen Frame Retainer (x 2), the
Screen Frame Side Guide and the Bottom and Power Supply
Guide Pin, then close the Screen Making
Unit. 1 Connect the power cord to the machine,

and then connect the machine and
computer via a USB cable.

2 Turn the Power Switch of the machine on.

(D Connect the power cord (left).
(@ Connect the USB cable (right).
® Turn the Power Switch on.
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3. Installing the Printer Driver

Before Installation

34

Prepare a commercially available USB cable
(less than 3 m (10 feet), compliant with Hi-Speed
USB).

@ 'mportant

* If you use a USB cable that is 3 m (10 feet)
or longer or a non-standard USB cable, it
may not operate correctly.

* If you connect or disconnect the USB cable
when not instructed to do so, the installation
may not be performed correctly and data
may not be able to be transmitted. In this
case, uninstall the printer driver and then in-
stall it again.

Uninstallation Procedure:
For Windows » P. 37
For Mac OS P P. 40

* Make sure to follow the instructions during
installation. Do not install the printer driver
from [Add Printer]. The installation may not
be performed correctly and data may not be
able to be transmitted.

* Log on to Windows with an account (Ad-
ministrator, etc.) that has the authority to
change the system settings.

* This printer driver does not support server
OS or printer sharing.

* When reinstalling a printer driver of the same
series to Windows, such as when updating
the driver or changing the cable connection
method, it is necessary to delete the driver
package. Uninstall the printer driver before
performing a new installation.

Dﬂ Uninstallation Procedure (Windows)
» P.37

The printer driver can also be installed manually
as required (Windows only).

Manually Installing the Printer Driver



Installation

3. Installing the Printer Driver

I Windows
Installation Procedure

@ 'mportant

* When upgrading the printer driver, uninstall

the old version of the driver first.

e Install the printer driver before connecting

1

the machine.

Insert the included [RISO GOCCOPRO
Printer Driver] CD-ROM into the CD-ROM
drive of your computer.

The installer is automatically started.

|
«u

Q If the [User Account Control] dialog
NOTE box appears, click [Yes].

If the installer does not start up, double-click
on the [Install.exe] file on the CD-ROM.

Select your language from the drop-down
list, and click [OK].

E:[ EO Printer Eriver Setup E

Select your language.

ﬁngnsh (English) B
Cancel |

3 When [Before installation] dialog box

appears, click [Next].
Follow the instructions in the dialog box.

Click [Install] in the [Ready to install]
dialog box.

The installation process is automatically
started.

Continue with the installation even if the
[Windows Security] dialog box is displayed.

Ready to install the printer driver.

"7, If you select the [Install also the Us-
Note ers Guide (PDF)] check box, you can
check the users guide (this docu-
ment) from [All Programs] > [RISO] >
[GOCCOPRO QS2536 Series] in the
Windows Start menu.

Connect the machine to the computer
via a USB cable, and then turn the power
switch of the machine on.

@ Connect the USB cable.
@ Turn the Power Switch on.
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3. Installing the Printer Driver

7 When the [USB port setting] dialog box
appears, click [OK].

8 Click [Show “ReadMe” text.].

Instalation of the RISO Printer Driver is completed.

Restart your PC before use.

Read the "ReadMe" text before using the RISO Printer

river.
It contains important information about driver use.

Show "ReadMe” text.

¥ Reboot the PC now.

@ 'mportant

Make sure to read the cautions for use
before using the machine.

9 Select the [Reboot the PC Now] check
box, and click [Finish].

The computer is rebooted automatically.
If the [Found New Hardware] dialog box is
displayed, click [Cancel].

"7, If you do not want to reboot the
NOTE computer immediately, deselect the
[Reboot the PC now.] check box be-

fore clicking [Finish].

36

10 After the computer has rebooted, open
the [Devices and Printers] dialog box and
check that [RISO GOCCOPRO QS2536]
is installed.

11 Remove the [RISO GOCCOPRO Printer
Driver] CD-ROM from your computer.

Checking the Version
Information

Display the printer properties dialog box, and
click the [About] tab.

RISO GOCCOPRO Q52536

e | = T

@ Version
The version of the printer driver that is in-
stalled

@ Language

The language of the printer driver that is in-
stalled

(3 Model

The model name of the machine
“RISO GOCCOPRO QS2536”
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Uninstallation Procedure

@ 'mportant

* To uninstall the printer driver, it is necessary
to log on to Windows with an account (Ad-
ministrator, etc.) that has the authority to
change the system settings.

e Uninstall the printer driver with the power
switch of the machine turned OFF or the
USB cable disconnected.

1 Start the uninstaller.

: FOI’WIndOWS1O ..............................................‘:

: Click [Start] > [RISO GOCCOPRO QS2536
: Series] > [Uninstaller]. :

..........................................................................

Open the [Apps] dialog box, and click
: [Uninstaller] for [RISO GOCCOPRO QS2536 :
Series]. :

..........................................................................

: FOrWindOWS 7 R L L L L L L L L L LR LEL

 Click [Start] > [All Programs] > [RISO] >
[GOCCOPRO QS2536 Series] > [Uninstaller].

..........................................................................

2 Select your language from the drop-down
list, and click [OK].

Select your language.
ﬁnglish (English) E|I
oo |

3 Click [Next].

Select [RISO GOCCOPRO QS2536], and
click [Next].

Click [Uninstall].

7, If the [Uninstall also User's Guide
NOTE (PDF)] check box is selected, the in-
struction manual (PDF format) will be
uninstalled as well.
M

Ready to uninstall the printer driver.

Printer name:
RISO GOCCOPRO Q52536

[V Uninstall also User's Guide (PDF)

To continue uninstalation, click the [Uninstal] button.

Back. l Uninstall I ' Cancel

Click [Finish].

When uninstalling the printer driver, be sure
to reboot the computer.

Qi If the [Reboot the PC now.] check
NOTE box is selected, the computer reboots
when [Finish] is clicked.

Uninstallation of the RISO Printer Driver is complet

I you wil install the printer driver again, re:
instalation.

¥ Reboot the PC now.
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3. Installing the Printer Driver

I Mac OS
Installation Procedure

@ 'mportant

* When upgrading the printer driver, uninstall
the old version of the driver first.

e Install the printer driver before connecting
the machine.

1 Insert the included [RISO GOCCOPRO
Printer Driver] CD-ROM into the CD-ROM
drive of your computer.

|
|

YA

2 Double-click the [RISO GOCCOPRO
QS2536.pkg] installer.

3 In the [Introduction] dialog box, click
[Continue].

38

4

In the [Installation Type] dialog box, click
[Install].

e0 ‘& Install RISO GOCCOPRO Q52536 -

Standard Install on “Mac OS 10.11"

ol o tuction This will take 499 KB of space on your computer.

Click Install to perform a standard installation of this software
on the disk “Mac 0S 10.11".

© Destination Select
© Installation Type
Installation

Summary

Change Install Location...

"7, To change the installation destination

NOTE to something other than “Macintosh

HD”, click [Destination Select], and
select the installation destination.

Enter [Username] and [Password], and
click [Install Software].

The installation process is automatically
started.

7~ Installer is trying to install new software. Type your

I i password to allow this.

Username: RISO Taro

Password: I ........ | I

Cancel Install Software

When [This installation was successful]
appears in the [Summary] dialog box, click
[Close].

Reboot your computer.

Double-click [Printers & Scanners] in the
[System Preferences] dialog box.

The [Printers & Scanners] dialog box is dis-
played.
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9 Connect the machine to the computer via a Checking the Version

USB cable, and then turn the power switch Information
of the machine on. :
Display the printer settings dialog box, and select

[About] from the drop-down list.

Printer: | RISO KAGAKU CORPORATION GOCCOPRO Q52536
Presets: = Default Settings

Copies: D

Pages: @ All
(From: 1 to: 1

Paper Size: = Custom 210 by 297 mm

. . s |
Orientation: ‘1

About

~a

¥

(D Connect the USB cable. RIS0 COCCORRO Q52598

@ Turn the Power Switch on.

— -

Copyright(c) = RISO KAGAKU CORPORATION

10 Check that the machine has been detected
and [GOCCOPRO QS2536] is displayed.
8000 (<> = Printers & Scanners [ o

— PDF Hide Details Cancel
= sy oo, S
Open Print Queue...
M Options & Supplies... @ MOdeI
e The model name of the machine
“RISO GOCCOPRO QS2536”
[] Share this printer on the network | Snaring Preferences... @ Ve rSion
e The version of the printer driver that is installed
Default printer: | Last Printer Used B N
Default paper size: M;B ?

11 Remove the [RISO GOCCOPRO Printer
Driver] CD-ROM from your computer.
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Uninstallation Procedure

@ 'mportant

Uninstall the printer driver with the power
switch of the machine turned OFF or the USB
cable disconnected.

1 Double-click [Printers & Scanners] in the
[System Preferences] dialog box.

2 In the [Printers & Scanners] dialog box,
select the [GOCCOPRO QS2536] check
box, and click [-].

000 < i Printers & Scanners |D. Ol

RISO KAGAKU CORPORATION

orintore

—_ RISO KAGAKU CORPO...

é © Idle, Last Used :H; L

w |__Open Print Queue.. |
| Options & Supplies... |

Location: K] d-ieipujape Sur
Kind: RISO GOCCOPRO Q52536
Status: dle

|| Share this printer on the network ~ Sharing Preferences...

Osfaultprinter:  Lsstprimer Used [
Default paper size: "445 2

3 In the [Printers & Scanners] dialog box,
confirm that [GOCCOPRO QS2536] has

disappeared.
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Operating and Setting Screen MakKing...........ccccveeeiiiiiniiiieeeeeeieeene. 42
WINAOWS .. 42
Transmitting the Original Data..............cocooiiiii e, 42
Registering the Screen Frame Size on the [Environment] Tab ................. 43

Setting the Screen Frame Size and Screen Making Process on the

[LayOUt] Ta ..o 46
Setting the Screening Type on the [Image] Tab........c..cccoovviiiiiic, 48
IMAC O e 50
Transmitting the Original Data...........cccooiiiii 50
Registering the Image Area ... 51
Setting the Screen Frame Size in the [Option] Dialog BoX ....................... 53
Setting the Screen Making Process in the [Layout] Dialog Box ............... 54
Setting the Screening Type in the [Image Setting] Dialog Box................. 55
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4. Setting the Printer Driver

Operating and Setting Screen Making

This section describes the procedure for transmitting original data to the machine and the settings that can
be configured in the printer driver.

42

I Windows

Transmitting the Original
Data

Transmit original data created on a Windows
computer to the machine.

You can change settings such as image quality
using the printer driver.

@ 'mportant

* Make sure to check that the image fits within
the image area before transmitting the orig-
inal data.

Image Size and Orientation » P. 27

* Make sure to check the page layout be-
fore transmitting the original data, such as
whether the original data contains multiple
pages. Also make sure that the previous
screen making operation is complete and
a new screen frame has been set before
transmitting the original data.

Handling Original Data » P. 28

1 Create original data using an application
of your choice on your computer.

2 Perform the printing procedure in the
application to display the [Print] dialog
box.

3 Select [RISO GOCCOPRO QS2536] in
[Printer Name].

4 Click [Properties] for the printer.

5 Configure the various settings on the
[Layout] tab and [Image] tab.

PE— =
Lavout | Bhoge [ About:
—
© portratt © Landscape
[Bzoom
(so
(50 - 200
[E mirror image.
—
[ |
__Mmledeﬁuk

[Layout]: Contains settings regarding the screen
frame size and screen making process.

© screen-cove
Abcd ® soidook

© sim
©or

[Image]: Contains settings regarding the screening
type.

Setting the Screen Frame Size and Screen
Making Process on the [Layout] Tab P> P. 46

Setting the Screening Type on the [Image] Tab
> P 48

6 When the settings have been made, check
a preview in [Preview], and click [OK].

7 When the dialog box returns to the [Print]
dialog box, click [Print].
The [Preview] dialog box appears.

8 Confirm the size and orientation of the

image and that the image is contained
within the image area, and click [Continue].

The original data is transmitted from your
computer to the machine.
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Registering the Screen Frame Size on the [Environment] Tab

@ 'mportant

The screen frame size must be registered before performing screen making.

When registering the screen frame size, make sure to check the relationship between the screen making
direction and size.

Information on Screen Making » P. 25

Register the screen frame size in the [Devices and Printers] dialog box.

~7 The screen frame size cannot be set when performing the print operation in the application (while
noTeE transmitting the original data).

Click [Frame size entry] on the [Environment] tab in the [Properties] dialog box of the printer driver to show
the [Frame size entry] dialog box.

GOCCOPRO Q52536 Properties (m)'@-- N AT
General | Sharng | Pots | Advanced | Color [secut]| Envirormert [} o -
Width: 25.00 =l inch n
[23.23 - 25.00]
ength: g B o
=mx () S
Thickness: [01..75;4.77]; inch @
Name: output03 I Add ]]
output01
output02 ( Clear
i\ Move Up
} Move Down
Import ] | Export ]
o]
@ Click [Frame size entry]. @ Set the screen frame size in the [Frame size entry]
dialog box.
Item Description Setting Values Details
A mm/ Switches the unit of mm Select the desired item from the drop-
inch measurement inch down list.
. Width of frame outer 590 mm to 635 mm . . .
B Width dimensions (23.23" to 25.00") Enter the dimensions.
Length of frame outer| 310 mm to 914 mm , , .
C Length dimensions (12.20" to 36.00") Enter the dimensions.
. . 20 mm to 45 mm Enter the dimensions.”
D | Thickness | Thickness of frame (0.79"t0 1.77" | The default value is 40 mm (1.57").
E Name Registered name for - Enter the name.
screen frame size

The underlined value of the setting values indicates the default value.
*Enter the value in increments of 1 mm (0.01").
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4. Setting the Printer Driver

7 If the registered screen frame size is not reflected, log on to Windows with an account (Administrator,
NoTE  etc.) that has the authority to change the system settings, and then register the screen frame size
again.

* The range of values that can be entered is the same as the range of screen frame sizes supported
by the machine.

* The image area differs according to the screen frame size.
Direction and Size of Screen Making P P. 25

Margin and Image Area P P. 26

A maximum of 30 screen frame sizes can be registered.

Numerals, letters, spaces, and symbols can be used in a registered name. A maximum of 30 characters
can be entered.

However, the following characters cannot be used.

Character Name
! Double quotation mark
* Asterisk
/ Slash
Colon
Less than
Greater than
? Question mark
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4. Setting the Printer Driver

The procedure for registering the screen frame
size is indicated below.

1

2

3

4

In the [Devices and Printers] dialog box,
double-click the [RISO GOCCOPRO
QS2536] icon.

In the [RISO GOCCOPRO QS2536] dialog
box, click [Printer], and select [Properties].

In the [RISO GOCCOPRO QS2536
Properties] dialog box, click [Frame size
entry] on the [Environment] tab.

In the [Frame size entry] dialog box, set
the screen frame size.

Configure the settings according to the
screen frame to use.

P e o0 B

[23.23 - 25.00]
Length: 36.00 i inch
[12.20 - 36.00,
Thickness: 1.57 & inch
[0.79 - 1.77]

Name: Add

T

Move Up
Move Down

[ Import ] [ Export ]

7 The unit of measurement can be
NOTE switched. Enter the value in incre-
ments of 1 mm (0.01").

5 Register a name for the screen frame size.

Enter a name, and click [Add].

The registered name is shown in the list.

o sy

Frame ——
Width: 2500 ] [~
[23.23 - 25.00]
Length: 36.00 = inch
[12.20 - 36.00]
Thickness: ~ 1.57 & inch
[0.79-1.77)
I Name: output0d3 I Add
output0l
[ wovewn ]
Move Down |
[ Import ] [ Export ]

"7, * To erase a registered screen frame
NOTE  Size, select the screen frame size
and click [Clear].

e To change the order in which a
registered screen frame size is dis-
played, select the screen frame size
and click [Move Up] or [Move Down].

When the settings have been made, click
[Close].

In the [RISO GOCCOPRO QS2536

Properties] dialog box, click [OK] on the
[Environment] tab.
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Setting the Screen Frame Size and Screen Making Process
on the [Layout] Tab

Set the screen frame size and screen making process in the [Properties] dialog box of the printer driver
when performing printing in an application.

Select the [Layout] tab to show settings regarding the screen frame size and screen making process.

You can click [Entry] for [Job settings] to show another dialog box for registering new settings or recalling/
deleting existing settings.

—
| = Printing Preferences

p—
Entry J (=)
Name: k‘)
)
Status list:
ion: | - Clear
Offset (Left or Right): OFF - Detais ] _®
Offset (Top or Bottom): OFF /v DeGE)
[i]Pre\'leW |
™ e e R e
LV o] Com ) A A
O, ()
Item Description Setting Values Details

Maximum size 25 x 36 inch
(width 635 mm (25.00")  [Select the desired item from the drop-

X down list.
length 914 mm (36.00"))
A Frame Switches screen Enter the desired dimensions in the
size frame size [Custom] dialog box.
Custom Width: 590 mm to 635 mm (23.23" to 25.00")!

Length: 310 mmto 914 mm (12.20" to 36.00")!
Thickness: 20 mm to 45 mm (0.79"to 1.77")!

Registered Select a registered screen frame size.
B Pf:nrg'_t/ The output Portrait Select the desired value with the radio
scape’ orientation Landscape button.
The expansmn/ OFF (100% Select this check box to enable this set-
C | Zoom | contraction of the . d o
image ON (50% to 200%) ting and enter a zoom ratio.
D Mirror Reverses the OFF Select this check box to enable this set-
image® |image horizontally ON ting.
OFF Sel he desired i f he d
E | Rotation® | Rotates the image 90-degree © ect.t e desired item from the drop-
down list.
180-degree
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4. Setting the Printer Driver

Item Description Setting Values Details
Offset Tg?tﬁf;sse;r\ggth OFF Select [Right] or [Left] from the drop-
F | (Leftor | making position Left down list, click [Details], and enter the
Right | (in theglgﬂ/ri o offset width in the [Details] dialog box.
9 e leting Right Setting range: 0 mmto 700 mm (0" to 28.00")!
direction)
Offset Tg?tﬁgsgrgg:h OFF Select [Top] or [Bottom] from the drop-
G| (Topor making position Top down list, click [Details], and enter the
Bott%m) (in the '?op/bottom offset width in the [Details] dialog box.
> 0B, Bottom Setting range: 0 mm to 700 mm (0" to 28.00")!
direction)
H | Preview* vi[;ﬁ%?)t/r?eair?qf-e OFF Shows a preview of the image for screen
9 ON making in the [Preview] dialog box.
for screen making

Click [Entry], and register or delete out-
put settings. See J/K.

Select a registered output setting from
the drop-down list.

Job Registers and

I : recalls output -
settings .
settings

The registered
J Name name of the out- -
put settings

Enter a name and click [Enter] to register
new settings.’

Displays a list of the registered output
settings.
To erase registered settings, select the

The list of reg-
K | Status list| istered output -

settings registered name and click [Clear].
Recalls output Adds a UDS file to the list of output set-
L Import . - .
settings tings.
M | Export Saves output ) Saves the output settings shown in the list
P settings of output settings to a UDS file.

The underlined value of the setting values indicates the default value.
1 Enter the value in increments of 1 mm (0.01").

2 The horizontal (x) and vertical (y) zoom ratio are linked. To enter a separate horizontal and vertical zoom
ratio, select the [x/y independent magnification] check box.

3 See the appendix for information on how the output result (screen making direction) differs according to
the combination of [Portrait]/[Landscape], [Rotation], and [Mirror image].

Rotation/Mirror Image » P. 77

4 Details on the preview function are described separately.

Preview > P. 19

5 You can register up to 10 sets of output settings. A maximum of 20 characters can be entered.
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Setting the Screening Type on the [Image] Tab

Set the screening type in the [Properties] dialog box of the printer driver when performing printing in an
application.

Select the [Image] tab to show settings regarding the screening type.

You can click [Details] for [Photo type] to show another dialog box for adjusting the finish of the image.

laym' Image .m <A>
S T
Screening type: Screen-covered -
—
original
Screen frequency: 38 £l i

Abed (38 -200]

Ip
3 Screen ang gle: 37 = degrees
[0-90]
Photo type: Detais —@

Line art style: © Grain-touch
Output © screen-cavered

Abod © Solid-bok :
Text style: © Bold ] C

<‘ I )_
Brightness: Dark - U - Light
‘ —
0] High

Contrast: Low

[[QEdge enhancement (K\
N/
[¥ Tone smoothing @ @
- 3 3
al

© sim
© oFF

f

3
@ - 3
Restore default —

e
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Item Description Setting Values Details
Expresses gradation by changing the
Screen-covered size of dots according to the density of
i he original.
A Screening The halftone setting the origina , ;
type Expresses gradation by perforating or
Grain-touch not perforating the screen for each dot
according to the density of the original.
. Select [Screen-covered] for the screening
B frzcﬂzen: The flnzr:;gs of the 38 to 200 Ipi type to enable this setting, and enter a value.
q Y The default value is 38 Ipi (line per inch).
c Screen The angle at which Select [Screlen-hqovergd] for the screenllng
angle dots are arranged 0 to 90 degrees type to enable t is setting and enter a value.
The default value is 37 degrees.
D | Photo type | Image adjustment - Displays the [Details] dialog box. See I/J/K/L.
Gradations are expressed by the density
Grain-touch of perforation on the screen master (low
density for light areas and high density
g | Lineart The expression for dark areas).
style method for the text The text sections are expressed with half-
Screen-covered . .
tone dots (not suitable for fine text).
. The text sections are expressed clearly with
Solid-look . .
solid color (gradations cannot be expressed).
This makes the text thicker (to prevent
Bold .
patchiness).
F | Text style’ Text thickness Slim This makes the text slimmer (to prevent
crushed lines).
OFF No adjustment.
Original Example screenin
G | to Output pt e 9 - Shows an example of the current finish.
Image yp
H Restore | Restores the default i Returns all settings to their default set-
default settings tings.
| | Brightness The image 1to7 Adjust this using the slide bar.
9 brightness (1 = dark, 7 = bright) | The default value is 4 (center of the slide bar).
. 1to7 Adjust this using the slide bar.
J | Contrast | The image contrast (1 =low, 7 = high) | The default value is 4 (center of the slide bar).
K Edge en- Enhancement for OFF Select this check box to enable this set-
hancement image edges ON ting, and make the edges clearer.
Select [Screen-covered] for the screening
ON type to make this setting available, and se-
Tone The gradation lect this check box to enable the setting.
L : . . .
smoothing smoothness The number of gradations is automatical-
OFF ly determined according to the resolution,
Ipi, and angle.
M Original to | Example screening - Shows an example of the current finish.
Output type

The underlined value of the setting values indicates the default value.

* This can be set only if text information is contained in the original and the font type can be changed.
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I Mac OS ) Configure the various settings by selecting
L. L. [Option], [Layout], and [Image Setting]
Transmitting the Original from the drop-down list.
Data Switching the settings can be done using
the drop-down list below [Orientation].
B Presets: | Default Settings
@ 'mportant t’:‘;?
* Make sure to check that the image fits within e THEPN
the image area before transmitting the orig- e @
inal data. =
Image Size and Orientation » P. 27 wum
* Make sure to check the page layout be- »
fore transmitting the original data, such as
whether the original data contains multiple AR
pages. Also make sure that the previous [Option]: Contains settings regarding the screen
screen making operation is complete and frame size.
a new screen frame has been set before
transmitting the original data. o

Handling Original Data » P. 28

B a0 oo

~“7 The functions of the printer driver for Mac - -
NoTe OS are included in the application. _—
: Ofset (Laftor Right) | OFF
1 E Offs with (oftorFight 000 2800 inch
Open the original data using an g =
application of your choice. T
2 2 pF g | Hido Details cancel | (EEED
Select [Print] from the [File] menu in the '
application [Layout]: Contains settings regarding screen making
’ process.
3 Inthe [Print] dialog box, select
H H Presets: | Default Settings
[GOCCOPRO QS2536] from the [Printer] g - D‘“
drop-down list. P 9::;" o
4 _— fhw
Set the paper size (image area). :
: Screring ype: soid-iook)
Registering the Image Area P P. 51 S el
Printer: RlsoKM;AKuocRPoRmoNGoccanooszrsasB
Presats: | Defaut Settings
coiec [
e O A
(Gosze cosom @sohmmmzm’l > (o B (rmman =
orntaton: 1] |57 :
w:" g : [Image Setting]: Contains settings regarding the
wan: éig;?;ui; screening type.
e 57
2 poF [B | ide Detais Cancel
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4. Setting the Printer Driver

Setting the Screen Frame Size in the

[Option] Dialog Box » P. 53

Setting the Screen Making Process in

the [Layout] Dialog Box > P. 54

Setting the Screening Type in theé

[Image Setting] Dialog Box » P. 55

6 When the settings have been made, click
[Print].

The original data is transmitted from your

computer to the machine.

7 If the [Preview] check box is selected,
NOTE the [Preview] dialog box appears. Con-
firm the size and orientation of the im-

age and that the image is contained

within the image area.

Registering the Image Area

@ 'mportant

* The image area is registered here. This dif-
fers from the screen frame size.

* When setting the image area, make sure to
check the relationship between the screen
making direction and size.

¢ Enter the maximum size of the screen frame
that will be used for the image area.

Margin and Image Area » P. 26

~“ The functions of the printer driver for Mac OS
NoTE are included in the application.

1 Select [Print] from [File] on the menu bar.
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52

Click the [Paper Size] drop-down list on
the [Print] dialog box to display the list of
registered paper sizes (image areas).

The default value is [Maximum Size 457 mm x
759 mm] (17.99" x 29.88").

Printer: _ RISO KAGAKU CORPORATION GOCCOPR0 52538 [
Preses:  Defaut Settings B

cores ]

Pages: @Al
O From:

1 |t 1

Paper Sz ¢ Custom ) sasty s oes
Maximum Size 457x759mm
o

Oriectzt Manage Custom Sizes...
R s
Option B

Frame
Width: (25,00 |2 inch

et 12323-25.00)
Length: (36,00 [3] inch

11220-36.00)
Thickness: 157 |2 inch
0791771

(2) por [g | ride Dtas cancol | (TN

Click [Manage Custom Sizes] from the list.

Printer: RISO KAGAKU CORPORATION GOCCOPR0 52536 [
Presets: _Defaul Settings.

} 8500y iapincrs
|

Width: 2500 |2 inch
Tott (2323-25.00)
Length: (36,00 [2/ inch
(12:20-36.00]
Thickness: 157 |2 inch
0794771

2) [ por [g | vide Detais Cancel

When the [Custom Size] dialog box
appears, click [+].

Paper Size: 0in 0in
Width Height

Non-Printable Area:

User Defined <
0in
0in Top 0in
Left 0in Right
Bottom

Double-click the [Untitled] line.

PaperSize;  85in Min
Width Height
Non-Printable Area:
User Defined
.25in
25in o 25in
G s6in|  Rant
Bottom
+ — Duplicate

Configure the settings.

Paper Size@ 17.99 in @ 29.88in

Width Height

Non-Printable Area:
RISO KAGAKU CORPORATION GOC'

0in
0in 1) 0in
Left 0in Right
Bottom

+ — Duplicate e
? Cancel

@ Enter the name.

@ Enter the image area size in [Width] (landscape)
and [Height] (portrait) for [Paper Size].

3 Select [GOCCOPRO QS2536] in [Non-Printable
Area] (this causes all margins to be set to [0]).

@ Click [OK].

The paper size set in the [Print] dialog box
is displayed.

Printer: RSO KAGAKU CORPORATION GOCCOPRO Q52536 [

Presets: Default Settings

P |
Pages: DAl
e

pager s ¢ screent | e

orentation Merege Comem Sre |
=
opon B

Frame
Width: (2500 |2 inch
Tot1 [2323-25.00)

Length: (3600 |2 inch
(122036001
Thickness: 157 |2/ inch
10.79-1.77]
2 (por [ Hide Detais cancol | (TN
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Setting the Screen Frame Size in the [Option] Dialog Box

@ 'mportant

* When setting the screen frame size, make sure to check the relationship between the screen making
direction and size.

* The screen frame size you set is used for drawing the screen frame in the [Preview] dialog box. A pre-
view will not be displayed accurately if the specified image area size is not appropriate for the selected
screen frame size.

* Enter the maximum size of the screen frame that will be used for the image area.
Information on Screen Making » P. 25

Registering the Image Area »> P. 51

Set the screen frame size in the printer settings dialog box when performing printing in an application (when
transmitting the original data).

Select [Option] from the drop-down list to show settings regarding the screen frame size. Configure the
settings as required.

Printer: | RISO KAGAKU CORPORATION GOCCOPRO 52536 [
Presets: | Default Settings

Paper Size: | Custom 850 by 11.00 inches.

Orientation: @ @

ption

o
5‘ o
3

©

Width: | 25.00 emmgiiCh
Tot1 [23.23-25.00]

Length: | 36.00 qg_inch
[12.20-36.007
Thickness: 1.57 inch
0.79-1.777

[l

2 (oor [ (i i ]
Item Description Setting Values Details

A Width Widtgig;rr]asrigisouter 5(92%'22 Ig %nr)n Enter the dimensions.”

B Length Leng’:jr;n?‘fa::ir:r:esouter 3(11%23.1, Ig %400[“;“ Enter the dimensions.”

C | Thiskness | Thickness oframe | %076l 10 3571 | Getaut valoe s 40 mm (1,571

The underlined value of the setting values indicates the default value.

*Enter the value in increments of 1 mm (0.01").

~“7 The range of values that can be entered is the same as the range of screen frame sizes supported by
NoTE the machine.

Screen Frame Size > P. 25
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Setting the Screen Making Process in the [Layout] Dialog Box

Set the screen making process in the printer settings dialog box when performing printing in an application.

Select [Layout] from the drop-down list to show settings regarding the screen making process.

Printer: | RISO KAGAKU CORPORATION GOCCOPRO Q82536

Presets: | Default Settings

MIrror Image e OFF

Rotation

Offset (Left or Right)

C Offset width (Left or Right) 0.00
et (Topr S 17

Offset width (Top or Eoﬂnml 000

Preview

[OFF/ ON
OFF [OFF/ 90-degree/ 180-degree
OFF [OFF/ Right/ Left

28.00 inch

2800 inch

PoF [ Hide Details ]
Item Description Setting Values Details
A Mirror Reverses the image OFF Select the desired item from the drop-
Image? horizontally ON down list.
OFF Sel he desired i f he d
B | Rotation? | Rotates the image 90-degree elect .t © desired item from the drop-
down list.
180-degree
The offset width of OFF Select [Right] or [Left] from the drop-
c Offset (Left| the screen making Right down list, and enter the offset width in
or Right) | position (in the left/ 9 [Offset width (Left or Right)].
right direction) Left Setting range: 0 mm to 700 mm (0" to 28.00")!
The offset width of OFF Select [Top] or [Bottom] from the drop-
D Offset (Top| the screen making To down list, and enter the offset width in
or Bottom) | position (in the top/ P [Offset width (Top or Bottom)].
bottom direction) Bottom Setting range: 0 mm to 700 mm (0" to 28.00")!
Displays a preview of OFF Select this check box to enable this
E | Preview® | the image for screen setting, and the preview is displayed in
making ON the [Preview] dialog box.

The underlined value of the setting values indicates the default value.

1 Enter the value in increments of 1 mm (0.01").

2 See the appendix for information on how the output result (screen making direction) differs according to
the combination of [Rotation] and [Mirror Image].

Rotation/Mirror Image » P. 77

3 Details on the preview function are described separately.

Preview > P. 19
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Setting the Screening Type in the [Image Setting] Dialog Box

Set the screening type in the printer settings dialog box when performing printing in an application.

Select [Image Setting] from the drop-down list to show settings regarding the screening type.

7@

Printer: = GOCCOPRO QS2536 B
Presets:  Default Settings. B
comes [1 ]

Pages: @ All

From: 1 to: 1

Paper Size: | Custom B 200y207m

Orientation: @ @

Image Setting B

u o
in-touch (Standard)/ Grain-t m
n-touch (Line art)/ Solid-look

ed/Dot process(Ipi angle)

&)/
ich (Photo)/

en frequer cy\ 38] 38

“_/:—

200 Ipi
90 deg

©

Output:

Abcd

i

&

?) [ POF Hide Details  Cancel
Item Description Setting Values Details
No processing No processing is performed.
Expresses gradation by changing the
DOt. process size of dots according to the density of
(Ipi, angle) .
the original.
A | Screening | - o setting Grain.-touch (Standard) |Expresses gradation by perforating or
type Grain-touch (Photo) |not perforating the screen for each dot
Grain-touch (Line art) |according to the density of the original.
The text sections are expressed clearly
Solid-look with solid color (gradations cannot be
expressed).
Select [Dot process (Ipi, angle)] for the
; screening type to enable this setting,
B ¢ Screen The flnednetss of the 38 to 200 Ipi and enter a value.
requency ots The default value is 38 Ipi (line per
inch).
Select [Dot process (Ipi, angle)] for the
c Screen The angle at which 0 to 90 degrees screening type to enable this setting,
angle dots are arranged and enter a value.
The default value is 37 degrees.
D Original to | - Example screening - Shows an example of the current finish.*
Output type

The underlined value of the setting values indicates the default value.

* Not displayed when [Solid-look] is selected at [Screening type].
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Settings in the Custom Setting Mode .............oeeeeiiiiiiiieees 58
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Starting the Custom Setting MOde ..o 61
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Stopping the Custom Setting MOde .........coccviiiiiiii 61
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Settings in the Custom Setting Mode

58

The following settings can be made in the Custom Setting Mode.

Mode Setting : .
No. Mode Item Values Setting Range Details
001 Beep sound :
0001 ON The machine produces a beep sound.
00p |Screen master counter| i Shows the total number of screens that
(no. of screens) have been made on the Display.
Image expansion/ |0000 to ro o The setting for image expansion/contraction.
003 contraction 0050 5% 10 +5% The default value is 25 (£0%).
004 | Test print (check) - - Performs a test print with a check pattern.
005 Test print (grid) - - Performs a test print with a grid pattern.
006 Test print i i Performs a test print with a center black line
(center black line) pattern.
Screen making starts when the [START]
. 0000 OFF Key is pressed after reception of the orig-
0g7 | Automatic screen inal data is complete.
making switching , ;
Screen making starts automatically after re-
0001 ON . o .
ception of the original data is complete.
008 Centering the ) i Moves the Screen Making Unit to the center
Screen Making Unit of the screen maker.
009 Displaying the ) i Shows the version information for the machine
version information on the Display (the “XXYY” part of “Ver XX.YY”).
Screen master Shows the check result of the screen mas-
010 - - ;
sensor check ter sensor on the Display.
011 Screen making ) i Shows the check result of the screen mak-
pressure sensor check ing pressure sensor on the Display.
o012 | Screen Making Unit i i Shows the result of the Screen Making Unit
set switch check set switch check on the Display.
Frame bottom Shows the check result of the Frame bot-
013 - - .
sensor check tom sensor on the Display.
014 Thermistor i i Shows the thermistor temperature on the
temperature Display.
o015 | TPH voltage check i ) Shows the check result of the TPH voltage
(front) (front) on the Display.
TPH voltage check Displays the check result of the TPH volt-
016 - - _
(rear) age (rear) on the Display.
0000 200 mesh or higher
Screen Makin The heat level of the Thermal Print Head
017 iKINg 0001 100 to 180 mesh changes based on the mesh count of the
Energy Variables
Screen Master.
0002 70 mesh or lower

the image expansion/contraction ratio.

The underlined value of the setting values indicates the default value.
* See the correspondence chart on the following page for the relationship between the setting values and
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® Relationship between the setting values for the image expansion/contraction (Mode No. 003) and the

image expansion/contraction ratio

. Expansion/ . Expansion/ . Expansion/ . Expansion/

\S/:ngg Coﬁtraction 32:322 Coﬁt_raction 32:322 Coﬁt_raction 3?'322 Coﬁtraction

Ratio (%) Ratio (%) Ratio (%) Ratio (%)
0 -5.0 13 2.4 26 +0.2 39 +2.8
1 -4.8 14 2.2 27 +0.4 40 +3.0
2 -4.6 15 -2.0 28 +0.6 41 +3.2
3 -4.4 16 -1.8 29 +0.8 42 +3.4
4 -4.2 17 -1.6 30 +1.0 43 +3.6
5 -4.0 18 -1.4 31 +1.2 44 +3.8
6 -3.8 19 -1.2 32 +1.4 45 +4.0
7 -3.6 20 -1.0 33 +1.6 46 +4.2
8 -3.4 21 -0.8 34 +1.8 47 +4.4
9 -3.2 22 -0.6 35 +2.0 48 +4.6
10 -3.0 23 -0.4 36 +2.2 49 +4.8
11 -2.8 24 -0.2 37 +2.4 50 +5.0

12 -2.6 25 +0 38 +2.6
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5. Custom Setting Mode

Operating the Custom Setting Mode

The Custom Setting Mode enables the various settings related to the screen making operations of the ma-
chine to be made.

Settings in the Custom Setting Mode can be made on the Control Panel of the machine.

S

®

4 RESET

STOP

©

®

@ Display
Displays the Custom Setting Mode number and entered value.
@ RESET Key

Starts the Custom Setting Mode.
Also press the [RESET] Key while in the Custom Setting Mode to reset the entered value.

3 STOP Key
Stops the Custom Setting Mode.

Confirms the Custom Setting Mode number and entered value.
Also press the [START] Key and [STOP] Key at the same time to decrease the value.

@ START Key
Increases the Custom Setting Mode number and entered value.
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5. Custom Setting Mode

Setting the Custom Setting Mode

IStarting the Custom
Setting Mode

Press and hold the [RESET] Key for 3 seconds
to start the Custom Setting Mode.

Mode number “000” is shown on the Display.

Selecting the Mode Number

Press the [START] Key to increase the value.
Press the [START] Key and [STOP] Key at the
same time to decrease the value.

Press the [STOP] Key to confirm the mode num-
ber.

The current entered value is shown on the Dis-
play.

7 RESET

Changing the Entered Value
(Setting)

Change the entered value while the entered val-
ue for the target mode is shown on the Display.

Press the [START] Key to increase the value.
Press the [START] Key and [STOP] Key at the
same time to decrease the value.

Press the [STOP] Key to confirm the entered
value.

The target entered value is shown on the Dis-
play.

IStopping the Custom

Setting Mode

Press and hold the [STOP] Key for 3 seconds to
stop the Custom Setting Mode.
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5. Custom Setting Mode

62

I Example Setting
Procedure

This example describes how to change the
“Beep sound” setting to set whether to produce
a beep sound when a key is pressed or an error
occurs.

1

Press and hold the [RESET] Key for
3 seconds to start the Custom Setting
Mode.

Mode number “000” is shown on the Dis-
play.

Press the [START] Key once to change
the mode number to “001”.

Press the [STOP] Key to confirm the mode
number as “001”.

The current entered value (“0001”) for mode
number “001” is shown on the Display.

Press the [START] Key once to change
the entered value to “0000".

Press the [STOP] Key once to confirm the
entered value as “0000”.

Press and hold the [STOP] key for 3
seconds to stop the Custom Setting Mode.

After the setting is changed, the machine
does not produce a beep sound when a key
is pressed or an error occurs.



Cleaning the Machine
Thermal Print Head

Main Unit Exterior

6. Maintenance
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6. Maintenance

Cleaning the Machine

1 Open the Screen Making Unit.

/\ Caution

) _ : To open the Screen Making Unit, push up
Do not perform operations (adjustments or re- the Screen Making Unit Open Lever to un-
pairs, etc.) on the machine other than those - lock it.

described in this guide. Make sure to contact
your dealer or authorized service representa-
tive for adjustments or repairs.

IThermaI Print Head

When dust adheres to the Thermal Print Head,
the screen may not be correctly perforated ac-
cording to the original data and graphics or text
may be missing or blur.

Gently rub the heat emitting part of the Thermal
Print Head with a cotton bud, etc. dampened 2 Check the position of the heat emitting
with alcohol to remove the dust. part of the Thermal Print Head.

The yellow part of the diagram is the Ther-
@ 'mportant mal Print Head.

 Before cleaning the machine, turn the power
switch off and give the Thermal Print Head
sufficient time to cool.

e Since the Thermal Print Head is very deli-
cate, avoid shocks or scratches with a hard
object.

e The Thermal Print Head may be dam-
aged by static electricity. Be sure to re-
move the static electricity in your body
before cleaning the Thermal Print Head.
Do not touch the Thermal Print Head except
when cleaning it.

* Do not use highly-soluble organic solvents
such as thinner and benzene for cleaning.

3 Gently rub the heat emitting part of the
Thermal Print Head with a cotton bud, etc.
dampened with alcohol to remove the dust.
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6. Maintenance

IMain Unit Exterior

To prevent stains from adhering to the main unit,
gently wipe the whole body with a neutral deter-
gent on a regular basis.

This may cause the color to fade, but will not
affect the performance of the machine.
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f. Troubleshooting

TrouBIESNOOTING ... 68
When Operating the Machine ... 68
When Operating the Printer Driver ... 69
When Images Are Not Transferred Correctly onto the Screen...............ccc........ 72
SELEITOr DISPIAY .. 74

67



7. Troubleshooting

Troubleshooting

When failure is suspected, check the following points before contacting your dealer or authorized service
representative.

68

IWhen Operating the Machine

<> The machine does not start even when the power switch is turned on.

Is the power cable connected correctly?

» Check if the power cable plug is firmly inserted into an electrical outlet.
* Check the power breaker.

Connecting the Cable and Power Supply »> P. 32

< Data is not transferred onto a screen.

Is the correct side of the screen master set?

Check the side of the screen master, and set it correctly.

<> The Custom Setting mode cannot be set.

(@7-le¢dP Has an error occurred?

Press the [RESET] Key on the Control Panel or turn the power of the machine off and then on
again.



7. Troubleshooting

IWhen Operating the Printer Driver

<> The [DATA] Indicator of the machine is on, but an imaged screen
has not been produced.

Is the data transmission on the computer side completed? (Is the output
operation of the application completed?)

* Double-click “RISO GOCCOPRO QS2536” in the [Printers] folder, and check whether the data
transmission is completed.

» Keep the screen saver turned off until the data transmission from your computer is completed.

Did you interrupt the outputting operation with application software?

1. Turn the power switch of the machine off.
2. Wait for about 10 seconds, and then turn the power switch back on.

(@ I=te {Ip Is the USB cable disconnected?

1. Cancel the transmission from your computer.
2. Turn the power switch of the machine off.

3. Correctly connect the USB cable again.

4. Turn the power switch of the machine on.

Do the settings of the application software (original size, original orienta-
tion) match the settings of the printer driver?

Match the settings of the application software with the settings of the printer driver.
Setting the Printer Driver p> P. 41
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7. Troubleshooting

<> Even when the data is transmitted from the computer, the screen
making process does not start.

Does the selected printer driver support the machine?
Select a printer driver that supports the machine, and then perform the outputting operation on

the application again.

@5l {p Does the status in “RISO GOCCOPRO QS2536” in the [Printers] folder
indicate that the data is waiting to be processed or in the process of
printing?

Wait until the data transmission from your computer is completed.

<> The screen frame size registered is not shown in the [Name] list.

Did you click [Add] next to the [Name] list after entering the size?

Click [Close] in the [Frame size entry] dialog box to close the dialog box, and then click [OK] (or
[Apply]) in the [Environment] tab.

Registering the Screen Frame Size »> P. 43

Has a screen frame size with the same name already been registered?

Register the screen frame size with a different name.

<> Values cannot be entered in [Custom] on the [Frame size] tab.

Did you try to enter a value that exceeds the setting range?

The screen frame sizes that can be entered are: 590 mm to 635 mm (23.23" to 25.00") in width,
310 mm to 914 mm (12.20" to 36.00") in length, and 20 mm to 45 mm (0.79" to 1.77") in thick-
ness. Enter a value within the range.

Setting the Screen Frame Size and Screen Making Process P P. 46
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7. Troubleshooting

<> A name cannot be entered in the [Frame size entry] dialog box.

Did you try to enter a name that exceeds the limit of the number of
characters you can enter?

You can enter up to 30 single-byte characters.

Did you try to use characters that cannot be registered?

The characters ", *, /, :, <, >, and ? cannot be used.

<> The preview display is not shown correctly.

(o )-ld P Is an offset set?

Adjust the offset to an appropriate value.
Setting the Screen Frame Size and Screen Making Process (Windows) » P. 46

Setting the Screen Making Process (Mac OS) » P. 54

Do the image area and screen frame settings match? (Mac OS only)

If the image area and screen frame settings do not match, the preview will not be shown correctly.
Check the image area and the screen frame size setting.

Registering the Image Area P P. 51

Setting the Screen Frame Size P> P. 53
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7. Troubleshooting

IWhen Images Are Not Transferred Correctly onto the
Screen

<> Part of the original data transferred onto the imaged screen is missing.

Does the size of the original data exceed the image area?

Maximum image area (width x length):
457 mm x 759 mm (17.99" x 29.88")
(with a frame thickness of 20 mm (0.79"))

Any part outside this image area is not transferred onto the screen.
Margin and Image Area » P. 26

<> The original data transferred onto the imaged screen contains a
white vertical line.

(@ =l Is there dust on the Thermal Print Head?

Gently rub the heat emitting part of the Thermal Print Head with alcohol, etc.
to remove the dust. \

Cleaning the Machine P> P. 64

<> The data transferred onto the screen is displaced or its edge is missing.

Does the size of the original data exceed the image area?

Any part outside the image area is not transferred onto the screen.
Check the size of the image area and original data.

Screen Making Area »> P. 26

Is the center of the screen frame aligned with the center mark (arrow) on the machine?
The machine makes screens with centering. Check whether the screen frame is set in the center of the machine.
Setting the Screen Frame » P. 30

(@1 {Jp Are the Screen Frame Retainer set to a narrow width?
In order to stabilize the screen frame, adjust the Screen Frame Retainer on the wide side.
Setting the Screen Frame P P. 30
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7. Troubleshooting

<> Characters are not transferred correctly onto the screen (the font
of the transferred characters differs from the original).

Is the output of the application software set to use the printer fonts?

In the application, configure the output settings not to use the printer fonts.

<> Graphics are not transferred correctly onto the screen.

Does the printer driver support the machine?

When original data is edited after a printer driver that does not support the machine is selected,
graphics may not be transferred correctly onto the screen.

After selecting a printer driver supporting the machine, edit the original data and produce an
imaged screen again.

<> Images are deformed/reduced in size.

Is the page scaling/page sizing setting of the application software set
to fit to the paper size?

Cancel the page scaling/page sizing setting in the application software.
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7. Troubleshooting

ISet Error Display

When an error has occurred in the machine or a part is not ready, a number indicating the error type ap-
pears on the Display.

Check the error number and perform the appropriate action indicated below.

Error No. Cause Action

d09-0266 The Screen .I\/Iakmg Unitis open or Firmly close the Screen Making Unit.
not closed firmly.

d83-0267 The screen frame is not set on the Set the screen frame on the machine.
machine.

1) Firmly close the Screen Making Unit.

2) Press the [RESET] Key to clear the error display.

3) Press the [RESET] Key to return the Screen

d09-0272 The Screen Making Unit was Making Unit to the screen making start position.
opened during screen making. 4) Open the Screen Making Unit, remove the
screen frame, and attach the screen master

again.

5) Perform screen making again.

F50-0220 The Thermal Print Head s at a Turn the power off and wait a while.
high temperature.
1) Remove the obstruction.
2) Press the [RESET] Key to clear the error display.
There is an obstruction below the 3) Pres.s the .[RESET] Key to rgturn the Sqrgen
. . Making Unit to the screen making start position.
F82-0275 Screen Making Unit and above the . .
screen frame. 4) Ifthe error occurrgd durmg screen making, open
the Screen Making Unit, remove the screen
frame, and attach the screen master again.

5) Perform screen making again.

1) Press the [RESET] Key to clear the error display.

2) Press the [RESET] Key to return the Screen
Making Unit to the screen making start position.

The Screen Making Unit reached|3) Open the Screen Making Unit, remove the
F92-0274 the Bottom side of the screen screen frame, and attach the screen master
frame during screen making. again.

4) Check the screen frame size setting (for Win-
dows) or the image area setting (for Mac OS),
and perform screen making again.

@ 'mportant

If [Pxx-xxxx] (service call) or [Exx-xxxx] (maintenance call) is shown on the display, check the error num-
ber, and contact your dealer or authorized service representative.
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Appendix

Manually Installing the Printer Driver

This section describes the procedure for manually installing via a USB cable connection (without using the

installer).

I Manual Installation
Procedure (Windows)

@ 'mportant

* To install the printer driver, it is necessary
to log on to Windows with an account (Ad-
ministrator, etc.) that has the authority to
change the system settings.

e This printer driver does not support printer
sharing.

1 Turn the power of the screen maker on,
and connect a USB cable.

2 Start the computer.

3 Connect the USB cable to the computer.

@ 'mportant

If you are using Windows 7, do not proceed
to the next step until [Device driver software
was not successfully installed] appears on the
task tray.

4 Start [Device Manager].

Click [Control Panel] > [Hardware and
Sound] > [Device Manager].

5 Click [Other devices], right-click on the
screen maker name, and select [Update
Driver Software] from the displayed menu.

I For Windows 10 / Windows 8.1 (IR

If the name of your screen maker is not dis-
: played, click [Action] > [Scan for hardware :
: changes]. :

..........................................................................

6 Click [Browse my computer for driver
software].

7 Insert the included “RISO GOCCOPRO
Printer Driver” CD-ROM into the CD-ROM
drive of your computer.

76

8 Click [Browse], select the following folder,

and then click [OK].

* For a 32-bit operating system:
(CD-ROM) > [Windows 32-bit] > [Driver] >
[Windows] > [English]

* For a 64-bit operating system:
(CD-ROM) > [Windows 64-bit] > [Driver] >
[Windows] > [English]

9 Select your screen maker from the list,
and click [Next].

10 Click [Close], and reboot the computer.

11 Giick [Control Panel] > [Hardware and
Sound] > [Devices and Printers], right-
click on the installed printer, and select
[Printer Properties] from the displayed
menu.

12 Click [Print Processor] on the [Advanced]
tab.

13 Click the following print processor from the
[Print processor] list.

* For a 32-bit operating system: R35V8RP
* For a 64-bit operating system: R35V6RP

14 select NT EMF1.008] from the [Default
data type] list, and click [OK].

15 Print a test page from the [General] tab.

16 Click [OK] to close the dialog box.



Appendix

Previewing the Output Result

I Rotation/Mirror Image - Original Data with ﬂ
The output result (screen making direction) differsac- Landscape Orientation
cording to the combination of [Portrait)/[Landscape], . o
[Rotation], and [Mirror image] set on the [Layout] tab ® When [Portrait] is set for the output direction

of the printer driver settings, as indicated below. Rotation

Original Data with ﬂ
Portrait Orientation

® When [Portrait] is set for the output direction

o0 pha
4

CYEI AR

Y

o O O ”

“ = “ g ® When [Landscape] is set for the output direction
g «D

o -0 \ -

® \When [Landscape] is set for the output direction

Mirror image

180°

=

a0
4

a0 20

DNE IR

7 * When [Landscape] is set for the output
o= direction, the image is rotated 90 degrees
clockwise.

* The image is rotated by the application
control, so that the output result may
differ from the indicated images above.
Make sure to check the image orientation
in [Preview].

* As a result of image rotation, parts of the
image may end up outside the image area
and be cut off. Use [Preview] to check a
preview of the image.

180°

a0 0o
¥

EIRNE )

IO
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Appendix

Consumables and Their Disposal

Consumable specifications and types are subject to change without notice.
For details, contact your dealer or authorized service representative.

I Screen Master
Use a screen master recommended for the machine by RISO.
Using an inappropriate screen master can cause the machine to malfunction or other problems.
The recommended products are as follows.

Product Name

Features

RISO DIGITAL SCREEN  |QS70P56-30
MASTER QS70P113-30
RISO DIGITAL SCREEN | 70P-56-30 PINK
QS MASTER 70P-113-30 PINK

This screen master is 70 mesh per inch type for
water-based ink and solvent type ink. Appropri-
ate for textile printing.

This is also suitable for the ink which contains rel-
atively large pigments such as gold ink.

RISO DIGITAL SCREEN
MASTER

QS120P56-50

QS120P113-50

RISO DIGITAL SCREEN
QS MASTER

120P-56-50 PINK

120P-113-50 PINK

This screen master is 120 mesh per inch

type for water-based ink and solvent type ink.

Appropriate for textile printing.

This screen master is suitable for printing both
solid images and fine text/lines.

High quality textile printing is also supported.

RISO DIGITAL SCREEN
MASTER

QS200P56-50

QS200P113-50

RISO DIGITAL SCREEN
QS MASTER

200P-56-50 PINK

200P-113-50 PINK

This screen master is a 200 mesh per inch type
that supports both water-based ink for textile
printing and solvent type ink for printing on plas-
tics, metals, and metal coated surfaces.

This is suitable for printing fine text, lines and dot
screen image.

Product Name Product Name
50P-56-20C 225P-56-20C
50P-113-20C 225P-113-20C
100P-56-20C 250P-56-20C

RISO DIGITAL SCREEN | 100P-113-20C RISO DIGITAL SCREEN  [250P-113-20C

QS MASTER 135P-56-20C QS MASTER 270P-56-20C
135P-113-20C 270P-113-20C
180P-56-20C 300P-56-20C
180P-113-20C 300P-113-20C

"7, The recommended screen masters are subject to change. For details, contact your dealer or autho-
NOTE rized service representative.

IDisposaI of a Depleted Screen Master and its Core

Dispose the depleted screen master and its core according to the disposal rules of your local community.

When it is necessary to segregate waste, refer to the following table.

Part Name Material
Core Paper
Screen Master Polyester
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Appendix

Specifications

GOCCOPRO QS2536

Screen making method

High-speed digital screen making

Screen-making time

Approx. 200 sec (A2 (420 mm x 594 mm (16.54" x 23.39")) image area size)

Image area size
(width x length)

Minimum: 10 mm x 10 mm (0.39" x 0.39")
Maximum: 457 mm x 759 mm (17.99" x 29.88") (with a frame thickness of 20 mm (0.79"))
455 mm x 734 mm (17.91" x 28.90") (with a frame thickness of 45 mm (1.77"))

Resolution

600 dpi (perforation density: 1200 dpi) x 1200 dpi

Control Panel

Resin molded buttons/7 segment display

Write start position

90 + 2 mm (8.54" + 0.08") from the Top side

Margin

45 mm (1.77") or more on the Bottom side
45 mm (1.77") on the Front side, 45 mm (1.77") or more on the Rear side

Screen making
position accuracy

+ 0.5 mm (0.02") or less (position accuracy when repeatedly making screens)

Custom Setting Mode

Beep sound/Screen master counter (no. of screens)/Image expansion/
contraction/Test print (check, grid, or center black line)/Automatic screen
making switching/Centering the Screen Making Unit/Displaying the version
information/Screen master sensor check/Screen making pressure sensor
check/Screen making unit set switch check/Frame bottom sensor check/
Thermistor temperature/TPH voltage check (front and rear)/Screen Making
Energy Variables

Screen frame size
(Outer dimensions)
(width x length)

Minimum: 590 mm x 310 mm (23.23" x 12.20") (with a frame thickness of 30 mm (1.18"))
Maximum: 635 mm x 914 mm (25.00" x 36.00")

Screen frame thickness

20 mm to 45 mm (0.79" to 1.77")

Memory capacity

128 MB

Power source

AC 100-240V,50-60Hz, 3.6 -14A

Power consumption

Maximum: 300 W
When standing by: 50 W or lower

Dimensions . ) " " "
(W x D x H) During use: 1215 mm x 800 mm x 410 mm (47.83" x 31.50" x 16.14")
Required space ; ] "
(W x D x H) 1230 mm x 800 mm x 480 mm (48.43" x 31.50" x 18.90")
Weight Approx. 71 kg (157 1b)

Safety information

Indoor, pollution degree 2%,
At altitudes of 2000 m or lower

Accessories

Driver CD-ROM
Driver EULA
Privacy protection sheet

*The pollution degree of the usage enviroment due to dirt and dust in the air. Degree “2” corresponds to a
general indoor enviroment.

® Note

* Please note that due to improvements and changes to the machine, some images and explanations in
this guide may not correspond to your machine.

* The specifications are subject to change without prior notice.
* Note that RISO will not be held responsible for anything resulting from the use of this guide or the

machine.
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Index

A

Automatic screen making switching ......... 58, 79
B

Beepsound ... 58, 62, 79
BOId. ... 49
Bottom ..o 22,25
Bottom Guide Pin............coooviiiiiinnn. 23, 31, 32
Bottom Stopper Pin ..., 23, 31
Brightness .......oviiii 49
C

Centering the screen making unit ............ 58, 79
Cleaning the machine ..............cccooiiiiiinene. 64
Cleaning the thermal print head..................... 64
Consumables and their disposal .................. 78
Contrast ..o 49
Control panel........ccooooviiiiiiiiiiiins 22,24, 60
D

DATA indicator .........ccooiiiiiiiiiiiiiee, 24
Direction and size of screen making................ 25
Display ..oieiii 24,79
Disposal of a depleted screen master and its core
............................................................... 78
E

Edge enhancement ..., 49
Environment tab (Windows) ........................ 43
F

Features of this machine.............................. 18
Frame bottom sensor check .................. 58, 79
Frame Bottom Set ...........coooiiiiiiinnn. 23, 31
G

Grain-touch ..o 49, 55
I

Image area size ...........cocoiiiiiiiiiiiii 79
Image expansion/contraction ............... 58, 59, 79

Image setting dialog box (Mac OS) ............... 55
IMage Size .....coviiiii 27
Image tab (Windows) .........ccccooiiiiininnnen. 48
Independent magnification ........................... 47
Installation ...........cccoooiiiiii, 34, 35, 38, 76
L

Layout dialog box (Mac OS) .........ccccevvennnnen. 54
Layout tab (Windows) .........ccoeeveiiniiiiinnnnen. 46
Lineartstyle ..o 49
M

Maintenance ..o 63
Manual installation ..o 76
Margin ..o 26
Mirrorimage .......c.cooviiiiiiiiie 46, 54,77
N

Names of parts ........cocooviiiiiiiii, 22
O

OffSBL e 47,54
Original data .................. 2,25, 27,28,42,50, 77
P

Photo adjustment ... 49
Photo type .....covniiii 49
Power connector ...........cocoviiiiiiiiiiinene, 23
Power cord.......ooovviiiiiiiii 23, 32
Power switch ..........cooooviiiiinnn. 22,32, 36, 39
Preparing the machine .....................ol. 30
Previewing the output result ........................ 77
Printerdriver ...........ccoooiiiiii.l. 35, 42, 50, 76
Printer driver settings

........................... 41, 42, 43, 46, 48, 53, 54, 55
Process from screen making to printing ......... 18
Q

QS screen master .......ccocoviiiiiiiiii 78
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R

Registering the image area (Mac OS) ............ 51
Registering the screen frame size (Windows)... 43
RESET KEY ivieiiiiiiiiieiiiceee e 24, 60
Restore default ... 49
S

Screenangle.......coooiiiiiiiiiiii 49, 55
Screen-covered ... 49
Screen frame retainer ...............oooeeeennl 23, 31
Screen frame side guide .................c....e. 23, 29
Screen frame size ........ccociiiiiiiiiiinns 25, 53
Screen frame top guide ..........coiiiiiiiiiiinnen. 23
Screen freqUeNCY .......ovvvveviiiiiiiiiiiea, 49, 55
Screening type ...oooviiiiii 49, 55
Screen making area............cooeviiiininninninnns. 26
Screen making energy variables ............ 58, 79
Screen making operation ...........coocoiiieninnen. 42
Screen making position accuracy .................. 79
Screen making pressure sensor check...... 58, 79
Screen making unit ... 22, 30, 64
Screen making unit open lever ............ 22, 30, 64
Screen making unit set switch check ...... 58, 79
Screen master ..o 78
Screen master counter ...........cociiiennns 58, 79
Screen master sensor check .................. 58, 79
Screen master tension.............ccoiiiiiieinn. 29
Screen rotation ...........ccoviininnnnn. 27,46, 54,77
Settings in the custom setting mode................ 58
Setting the custom setting mode .................. 61
Setting the screen frame............c.cooiiiinn. 30
Setting the screen frame size.................. 46, 53
Setting the screening type ..........ccooeeeie. 48, 55
Setting the screen making process ......... 46, 54
SlM 49
Solid-100K ..viiiii 49, 55
Specifications ... 79
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StAgE v 22,30
Stage handle..........cooooiiiiiiiiiii, 22, 30
START KEY .. et 24, 60
STOP KEY erveiiiiiiiiiiiee e 24, 60
Switching the unit of measurement ............... 43
T

TENSION .o 29
Testprint ..o 58, 79
Text style ..o 49
Thermistor temperature ........................ 58, 79
Tone smoothing  .......coviiiiiiieas 49
) o T 23, 25
TPH voltage check ........c.ccoiiiiiiiinenen. 58, 79
Transmitting the original data ............... 28, 42, 50
U

Uninstallation...........cccooiiiiiiiin. 37, 40
Uninstalling the printer driver ........................ 33
USB POt e 23
Vv

Version information ..................... 36, 39, 58, 79
Z

ZOOM ettt 46
ZOOM FALO .euveieieieeei e 27



Notice for European Union Member States

RISO, the environment and the Waste Electrical and Electronic
Equipment Directive "WEEE Directive"

What is the WEEE Directive?

The purpose of the WEEE Directive is to reduce waste and ensure Electrical and

Electronic Equipment is recycled at the end of its useful life.

hi¢

What does the crossed out wheeled bin symbol mean?
The crossed out wheeled bin symbol indicates this product must be disposed of
separately to normal waste.

Please contact your RISO service agent for information about disposal.

What does the solid bar symbol mean?
The solid bar under the crossed out wheeled bin indicates this product was put on the

market after the 13th August 2005.
Who should | contact if | want more information about the

WEEE Directive?

You should contact your local RISO service agent for more information.
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Machine de création d’écran numérique
Modele: GOCCOPRO QS2536

Nous avertissons l'utilisateur que tout changement ou toute modification non
approuvé(e) peut invalider le droit de I'utilisateur a utilizer 'appareil.

CAN ICES-3(A)/NMB-3(A)

Avertissement

Cet appareil est un produit de classe A. Dans un environnement domestique, il
peu provoquer des intérferences radio. Si tel est le cas, I'utilisateur peut devoir
prendre des mesures adéquates.




Informations relatives a la sécurité (Fr)

Nous vous félicitons pour I'achat de cette machine.
Cette machine facile d’emploi sert a la réalisation d’écrans par procédé numérique.

Ce guide contient les instructions pour le fonctionnement de base de la ma-
chine, les précautions d’utilisation, les méthodes de manipulation des consom-
mables et un guide de dépannage.

Veuillez lire attentivement ce guide avant d’utiliser la machine. Reportez-vous
également a ce guide en cas de question pendant I'utilisation et chaque fois
gu’il est nécessaire. Servez-vous en avec la machine pour les nombreuses
années a venir.

¢ Microsoft et Windows sont des marques déposées ou des marques commer-
ciales de Microsoft Corporation aux Etats-Unis et/ou dans d’autres pays.

¢ Mac et Mac OS sont des marques déposées d’Apple Inc.

. 0 &l‘S‘. GOCCOPRO et RISORINC sont des marques commerciales ou
des marques déposées de RISO KAGAKU CORPORATION aux Etats-Unis et
dans d’autres pays.

¢ Tous les autres noms de produit et de société sont des marques déposées ou
des marques commerciales de chaque société respective.

¢ Les écrans et le contenu figurant dans ce guide peuvent différer du produit réel.

e Les écrans et les messages figurant dans les procédures peuvent varier en
fonction du type d’ordinateur et d’application (ce guide utilise des écrans de
Windows 7).

© Copyright 2020 RISO KAGAKU CORPORATION
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La notation dans ce guide

La notation, les symboles et la terminologie utilisés dans ce guide sont indiqués ci-dessous.

Notation des pages contenant des descriptions d’opérations
et de fonctions

Les pages contenant des descriptions des fonctions et des opérations utilisent la notation suivante. Aussi,
les noms des touches et des boutons de I'écran tactile ou de la fenétre de I'ordinateur sont indiqués entre
crochets [ ].

EEETE T @ Titre de chapitre
reparing the Ma ©) |

Crpmmens Speomeemess (2 Procédure  de  fonctionne-
i - ment
Une procédure de fonctionne-
ment est décrite par étapes.

ISetting the Screen
Frame

217

2 Loosen the Stage Handle to make the
Stage movable.

@ 'mportant

(3 lllustration du fonctionne-
ment

B | ==

3 Move the Screen Frame Side Guide
nnnnn 19 your Nl Screen Frame Retainer » P23

Indique une partie liée au
fonctionnement, par exemple,
de la machine, du panneau de
commande ou de I'écran d’un

Sido Guide.

7' Move the Stage while holding down the
ie Bottom Guide
side of the

ordinateur.
| |
Symboles utilisés dansce =~ Terminologie utilisée dans
guide ~ ce guide
&Warning Une mise en garde liée a la Dpr]nées Données image. et texte
sécurité. originales  [créées sur un ordinateur.

Pour plus de détails, voir L de lect g
‘Indications  d’avertisse- € processus de leclure des

&Caution ment” page 12 de ce guide. Reéalisation données originales envoyées
depuis un ordinateur vers la

d’un écran . .
— ; machine et de perforation
Un point important a noter| d’'un master d'écran.
@ 'mportant|iors de rutiisation de la| P RE—
machine. Valeur par a valeur initiale de chaque
- - - : . paramétre juste aprés la mise
Des informations supplé-| défaut sous tension de la machine.
g mentaires qu'il est pratique|
NOTE de connaitre lors de ['utili-|
sation de la machine. - Remarque concernant les
Indique une page de réfé-| écrans d’ordinateur
rence associée. i

La fagon dont les boites de dialogue, etc. s’af-
fichent, peut étre différente de celle qui est in-
diquée dans ce guide, en fonction de la version
du systéme d’exploitation utilisée sur votre ordi-
nateur.
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Mises en garde de securité

Cette section décrit les informations que vous avez besoin de connaitre avant d’utiliser cette machine. Lisez
cette section avant d'utiliser cette machine.

I Indications
d’avertissement

Les indications d’avertissement suivantes sont
utilisées pour garantir le fonctionnement correct
de cette machine et aussi pour éviter les dan-
gers pour le corps humain ou endommager le

| Branchement électrique

/N\ Warning

* Le cordon d’alimentation fourni est spéci-
fique a cette machine. Ne I'utilisez pas pour
d’autres produits électriques. Ceci pourrait

materiel. _ provoquer un incendie ou un choc élec-
Assurez-vous d’avoir parfaitement compris le trique.
contenu avant de procéder au texte principal.  Le cable d’alimentation ne doit pas étre atta-

ché ou enroulé afin d’éviter de provoquer

lindique qu'une ma- une surchauffe et un incendie.

nipulation  incorrecte

. sans tenir compte de
&Warnlng ce symbole peut pro-
voquer des blessures
graves, voire mortelles.

* N'utilisez pas de prise de dé-

rivation ni de multiprise. Ceci
pourrait provoquer un incendie

ou un choc électrique.

* Veillez a ne pas érafler, en-
dommager ou altérer le cordon %
d’alimentation. Veillez a ne pas
endommager le cordon dali-
mentation en plagant des objets
lourds dessus, en tirant dessus
ou en le pliant avec force. Ceci
pourrait provoquer un incendie

: ou un choc électrique.
Lieu d’installation * Faites attention & ne pas brancher ou dé-
? brancher le cordon d’alimentation avec les
mains mouillées. Ceci pourrait provoquer un
choc électrique.

Indigue qu'une ma-
nipulation  incorrecte
sans tenir compte de
&Cﬂ”tion ce symbole peut pro-

voquer des blessures
graves ou endomma-
ger du matériel.

/\ Caution

* Ne placez pas cette machine sur une sur-
face instable, comme une base qui bouge
ou une surface inclinée. Si cette machine

/\ Caution

tombe ou se renverse, elle pourrait provo-
quer des blessures.

* Eloignez cette machine des environne-
ments humides et poussiéreux. Le manque-
ment a cette instruction pourrait provoquer
un incendie ou un choc électrique.

* Cette machine n’est pas destinée a étre
utilisée par des enfants. Utilisez la machine
dans un endroit inaccessible aux enfants.

e Pour débrancher, ne tirez pas sur le cordon
d’alimentation (veillez & bien agripper la
fiche). Ceci pourrait endommager le cordon
et provoquer un incendie ou un choc élec-
trique.

* Si cette machine ne va pas étre utilisée
pendant un certain temps (pendant des va-
cances etc.), veillez a bien débrancher le cor-
don d’alimentation pour garantir la sécurité.

e Débranchez le cordon d’alimentation au
moins une fois par an et nettoyez les bro-
ches de la fiche et la zone qui I'entoure. La
poussiére accumulée a cet endroit pourrait
provoquer un incendie.
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IRaccordementéIa terre IManipuIation de la
~machine

/N\ Warning

e S’assurer de brancher le cor-

88

don d’alimentation a I'aide d’'un
conducteur de mise a la terre
dans la prise de courant avec
une prise de terre. Si la ma-
chine n’est pas mise a la terre,
un court-circuit peut se pro-
duire. Ceci pourrait provoquer
un incendie ou un choc élec-
trique.

/N\ Warning

* Ne placez pas de récipient rempli d’eau ni
d’objets métalliques sur cette machine. Si
'eau se renverse ou si I'eau ou les objets
métalliques tombent a l'intérieur de cette
machine, ceci pourrait provoquer un incen-
die ou un choc électrique.

* N'utilisez pas de vaporisateur de produits
combustibles ni de solvants inflammables
prés de cette machine. Si le gaz vaporisé
ou le solvant inflammable entre en contact
avec les piéces électriques qui se trouvent
a lintérieur du systeme mécanique, ceci
pourrait provoquer un incendie ou un choc
électrique.

* N’insérez pas et ne faites pas tomber de
corps étrangers comme des piéces métal-
liques ou des matériaux hautement com-
bustibles a l'intérieur de cette machine par
une de ses ouvertures. Ceci pourrait provo-
quer un incendie ou un choc électrique.

* N’enlevez pas les capots de cette machine.
Certaines parties de l'intérieur de cette ma-
chine sont soumises a des tensions éle-
vées. Le fait d’enlever les capots pourrait
provoquer un choc électrique.

* Ne démontez pas et ne modi- @
fiez pas cette machine. Ceci ‘
pourrait provoquer un incendie

ou un choc électrique.
 Latéte thermique et les piéces

métalliques a proximité sont

chaudes lorsque la machine

est sous tension, ou juste

apres la mise hors tension. Ne

les touchez pas afin d’éviter de

vous brdler. Lors du nettoyage

de la machine, attendez que

celle-ci ait refroidi.

* Ne jamais laisser quelgu’un qui ne connait
pas le fonctionnement de la machine la tou-
cher. Un accident risque de se produire en
touchant les parties dangereuses ou en dé-
marrant la machine par inadvertance.
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/N\ Warning

e Si cette machine émet une
chaleur excessive, de la fumée
Oou une mauvaise odeur, étei-
gnez-la immédiatement avec
Pinterrupteur  d’alimentation,
débranchez le cordon dali-
mentation et consultez votre
revendeur ou un représentant
du service aprés-vente agréeé.
Le manquement a cette ins-
truction pourrait provoquer un
incendie ou un choc électrique.
Pour de plus amples informa-
tions, consultez votre reven-
deur ou un représentant du
service apres-vente agréé.

* Si des corps étrangers pé-
nétrent dans cette machine,
éteignez-la  immédiatement
avec linterrupteur d’alimen-
tation de [l'unité principale,
débranchez le cordon dali-
mentation et consultez votre
revendeur ou un représentant
du service aprés-vente agréé.
Si vous continuez a utiliser
cette machine sans prendre
les mesures appropriées, ceci
pourrait provoquer un incendie
ou un choc électrique.

/\ Caution

* Ne jamais mettre ses doigts dans une ou-
verture, etc., de cette machine. Vous pour-
riez vous blesser.

* Si vous soulevez ou déplacez la machine,
assurez-vous de tenir la partie inférieure de
l'unité principale. En tenant la partie supé-
rieure de l'unité principale, vous risquez de
la faire tomber et de provoquer des bles-
sures.

* La machine pese environ 71 kg (157 Ib). Prenez
des précautions suffisantes lors de 'emballage,
de la mise en place et du déplacement de la
machine.

Faire attention a ne pas se
coincer les mains ou les
bras

Létiquette d’avertis-
sement indique le
risque de blessure si
votre main ou votre
bras est coincé dans
un couvercle ou une
fente d’insertion, etc.

® N’insérez pas vos mains et ne laissez pas
vos vétements étre coincés lorsque l'unité
de création d’écran est en mouvement. Cela
peut entrainer des blessures.
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I Etiquette de mise en garde
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En vue d'utiliser cette machine en toute sécurité, I'étiquette de mise en garde est collée sur cette unité.
Lisez attentivement les consignes de sécurité de I'étiquette lors de I'entretien de cette unité ou de son
utilisation.

N’6tez pas I'étiquette et gardez-la propre. Si I'étiquette n’est pas collée sur l'unité, s’est cornée ou est illi-
sible, contactez votre revendeur ou un membre du service aprés-vente autoriseé.

Emplacement de I'étiquette de mise en garde

Lemplacement des étiquettes (avertissement) est indiqué ci-dessous.

Coté Avant/Bas

Etiquette de précaution de la téte
d’impression thermique

Since the Thermal Print
Head is very delicate,
avoid shocks or
scratches with a hard
object.

118-28060-009

Coté Arriere/Haut

Etiquette d’avertissement

118-28059-000

Contenu de I’étiquette de précaution de la téte d’impression
thermique

Lemplacement indiqué par cette étiquette (téte d’impression thermique) a une température élevée. La téte
d’'impression thermique étant trés fragile, évitez les chocs ou les rayures avec un objet dur.

Contenu de I’'étiquette d’avertissement

Létiquette d’avertissement indique le risque de blessure si votre main ou votre bras est coincé lorsque
l'unité de création d’écran est en mouvement.
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Avant la premiere utilisation

I Précautions d’installation
Lieu d’installation

® [L'emplacement d'installation de cette ma-
chine doit étre décidé avec vous au moment
de la livraison.

® Le lieu dinstallation de cette machine doit
étre fixe. Si vous souhaitez déplacer cette
machine, consultez votre revendeur ou un re-
présentant du service apres-vente agréé.

® N’installez pas cette machine dans les en-
droits énumérés ci-dessous. Tout manque-
ment au suivi de cette précaution peut entrai-
ner un dysfonctionnement, une défaillance ou
un accident.

* Endroits exposés aux rayonne-
ments directs du soleil et en-
droits situés a proximité de fe-
nétres (recouvrez les fenétres
de rideaux si nécessaire)

* Endroits soumis a des changements sou-
dains de température

e Endroits extrémement chauds et humides
ou endroits froids et secs

e Endroits exposés au feu ou a la chaleur,
a lair froid direct (ex. climatiseur), a l'air
chaud direct (ex. chauffage) ou un endroit
ou la chaleur est transmise

* Endroits dotés d’'une mauvaise perméabili-
té et d'une mauvaise ventilation

* Les endroits poussiereux

* Emplacements a la résistance suffisante
tels qu’une table de travail

Remarques concernant
’environnement de
fonctionnement

® Installez la machine dans un endroit dont le
niveau figure dans la plage déterminée.
(Planéité pour l'installation: 10 mm (0,39") ou
moins en longueur et en largeur)

Pieds ajusteurs > P. 22

® |es conditions environne-
mentales appropriées sont
les suivantes

* Plage de températures:
15°Ca30°C
(59 °F a 86 °F)

* Plage d’humidité:
40 % a 70 %
(sans condensation)

Espace requis

Cette machine requiert I'espace suivant.

Unités: mm (pouce)

1230 (48,43)
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IPrécautions concernant IPrécautions d’utilisation
~ Manipulation

92

la connexion

Précautions lors de la
connexion a I’alimentation
électrique

® \eillez a bien brancher le
cordon d’alimentation correc-
tement afin d’éviter tout mau-
vais contact au niveau de la
fiche électrique.

® Placez cette machine a proximité de la prise
électrique.

Le pilote d’imprimante

Ce pilote d'imprimante est congu pour la créa-
tion d’écran par transmission des données origi-
nales a partir de votre ordinateur.

Le pilote d’imprimante est contenu sur le
CD-ROM fourni. Lors de la premiéere réalisation
d’un master d’écran, il est nécessaire d’installer
le pilote d’imprimante.

Précautions lors de la
connexion a un ordinateur

® Avant d'utiliser la machine, assurez-vous
d’installer le pilote d'imprimante a partir du
CD-ROM fourni.

@ 'mportant

Ne connectez pas la machine a l'ordinateur
avant d’avoir installé le pilote d'imprimante.

® La machine doit étre connectée a un ordi-
nateur via un cable USB disponible dans le
commerce (inférieur a 3 m (10 pieds), com-
patible Hi-Speed USB).

® | a tension maximale permise pour I'entrée et
la sortie du connecteur USB est de 5 V.

Cette machine est une machine de précision.
Ne pas placer d’objets lourds sur la machine
et ne pas lui faire subir de choc ou une pres-
sion excessive.

N’introduisez pas vos doigts ou vos mains
dans la téte thermique et dans les piéces
mobiles.

Ne pas déplacer l'unité de création d’écran
avec les mains. Utilisez le mode de configu-
ration personnalisée pour déplacer I'unité de
création d’écran au centre.

Ne coupez pas l'alimentation électrique et
ne débranchez pas le cordon d’alimentation
pendant le fonctionnement.

Lorsque la machine est en marche, ne pas
déplacer un cadre d’écran et ne pas déplacer
la machine.

Ne pas ouvrir 'unité de création d’écran pen-
dant son fonctionnement.

Cette machine contient des pieces de pré-
cision et des mécanismes d’entrainement.
N’effectuez que les procédures décrites dans
le présent manuel.

Nettoyer cette machine fréquemment. Si un
corps étranger se trouve sur un écran, la téte
thermique sera endommageée. Ne pas utiliser
de solvants organiques hautement solubles
tels que du diluant ou du benzéne pour le
nettoyage. Leur utilisation produira un décol-
lement du revétement et des pannes. Pour le
nettoyage, utilisez un détergent neutre.

Pour la machine, utilisez RISO Digital Screen
Master spécifié et RISO DIGITAL SCREEN
QS MASTER. La qualité n’est pas garantie
en cas d'utilisation d’autres écrans.

Master d’écran » P. 78
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Stockage du master d’écran

N’installez pas ces éléments dans les endroits
énumeéreés ci-dessous.

* Endroits  exposés  aux
rayonnements directs du
soleil et endroits situés a
proximité de fenétres (re-
couvrez les fenétres de ri-
deaux si nécessaire)

* Endroits soumis a des changements sou-
dains de température

¢ Endroits extrémement chauds et humides
ou endroits froids et secs

| bocuments a ne pas

imprimer

N’utilisez cette machine d’aucune maniere pou-
vant violer des lois ou des droits d’auteur établis,
méme si vous faites des copies pour votre usage
personnel. Consultez les autorités locales pour
plus de détails. En général, faites preuve de dis-
crétion et de bon sens.
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Caractéristiques de cet appareil

Cette machine est destinée a la réalisation d'écrans de sérigraphie numériques, congus exclusivement pour les masters de sérigraphie numériques RISO. Fixer un écran
au cadre et linstaller sur la machine pour lancer la réalisation de 'écran de sérigraphie. Ce document décrit la procédure jusqu'a l'étape “3. Réalisation d'un écran”.

I Processus de la réalisation de I’écran jusqu’a I'impression

— Installez le logiciel “RISO GOCCO- G Transmettre les données d’origine.
@) PRO Printer Driver” sur votre ordina- T |
O teur M- -
-] Q Print!
=—h —
Q | | [ %
E « — o}
Q (@)
— >
O I [
g % :m IIIIII W1 e IIQ
5
= E= | o '_"JU_“_“_H [\ C:I; Envoi des données d’origine:
Qo o Pour Windows P> P. 42
() Procédure d’installation: B Pour Mac OS » P. 50
Pour Windows » P. 35 )
Pour Mac OS b P. 38 La réalisation de I'écran démarre.
!\) Installer le cadre de 'écran sur la machine.
n
=
D~
©
Q
=
Q
=
o
-]
% La réalisation de I'écran est terminée.
g_) Parameétres du cadre de I'écran » P. 30
~
8~ Connecter la machine a l'ordinateur 0
— avec le cable USB, puis allumer la ma-
@ chine. ?
,&_,.’_ \ ]
(@)
-]
o
(0]
C? +  Utiliser une encre adaptée au type de
O‘ § tissu et a l'utilisation prévu.
S
% ©
=
D
(7))
23
(®)
)

Connexion du céble et source
d’alimentation » P. 32
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I Points clés de la fabrication

¢ Paramétrage de la taille du cadre de Iécran

Régler a I'avance le cadre de I'écran.

ﬁme size Ei
Frame —
Width: 50 ] [ah o)

[23.23 - 25.00]
Length: 36.00 S inch
[12.20 - 36.00]
Thickness:  1.57 ] inch
[0.79-1.77]

Taille du cadre de I'écran P P. 25

Paramétrage de la taille du cadre
d’écran (Windows) »> P. 43

Le type d’écran peut étre défini en fonc-
tion de l'image a transférer, le tissu sur
lequel imprimer, et I'encre utilisée.

[——
S =|
gl
A;Cd
E} B Fame s W' )
I3 o o
_ —
e —
-
frepw—
~~~~~~~~ o ey
l—— Comsa )
=) (e )

Paramétrage de la taille du cadre de 'écran
(Windows) » P. 46

Paramétrage de la zone d’'image
(Mac OS) » P. 51

Réglage du processus de réalisation de I'écran:
Pour Windows » P. 46
Pour Mac OS » P. 54

Réglage du type de d’écran:
Pour Windows » P. 48

Pour Mac OS » P. 55

€ L’Apercu

Vous pouvez visualiser un apercu de comment limage
sera transférée sur 'écran dans le logiciel fourni sous
[Apercu] avant de passer a la réalisation de 'écran.

¢ Limage est-elle intégralement dans la zone d'image ?
* Lorientation de 'image est-elle correcte ?

Taille du cadre d’écran (largeur du cadre)

> Epaisseur du cadre

Taille du cadre d’écran (longueur du cadre)

Epaisseur du cadre >

Vous trouverez plus d’informations sur la
zone d’'image et I'orientation dans ce guide.

Informations sur la réalisation d’écrans
» P.25

| Fonctionnalité de ta machine

La machine permet de reproduire du texte fin et des dégradés
avec une précision élevée par perforation de haute résolution
a 600 ppp (densité de perforation 1200 ppp) x 1200 ppp.

(Image)

AL AA

o

600 ppp 1200 ppp

Un traitement spécial peut étre nécessaire en fonction du type de support.
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Caractéristiques
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GOCCOPRO QS2536

Procédé de
réalisation de I'écran

Réalisation d’écran par procédé numérique ultra rapide

Durée de la
réalisation d’écran

Environ 200 sec. (taille de la zone d’image A2 (420 mm x 594 mm (16,54" x 23,39"))

Taille de la zone

Minimum: 10 mm x 10 mm (0,39" x 0,39")

d'image Maximum: 457 mm x 759 mm (17,99" x 29,88") (épaisseur de cadre de 20 mm (0,79")
(largeur x longueur) 455 mm x 734 mm (17,91" x 28,90") (épaisseur de cadre de 45 mm (1,77"))
Résolution 600 ppp (densité de perforation: 1200 ppp) x 1200 ppp

Panneau de commande

Boutons moulés en résine/Affichage 7 segments

Position de démarrage
d’écriture

90 + 2 mm (3,54" £ 0,08") du bord supérieur

Marge

45 mm (1,77") ou plus cbté inférieur
45 mm (1,77") c6té avant, 45 mm (1,77") ou plus coté arriere

Précision de la position
de réalisation d’écran

+ 0,5 mm (0,02") ou moins (précision de la position lors de la réalisation répétée
d’écrans)

Mode de réglage
personnalisé

Son bip/Compteur de master d’écran (nombre d’écrans)/Extension/contraction de I'image/
Test d’impression (vérification, grille ou ligne noire centrale)/Commutation de réalisation
d'écran automatique/Centrage de I'unité de réalisation d’écran/Affichage des informations
de version/Vérification du capteur du master d’'écran/Vérification du capteur de pression de
réalisation d’écran/Vérification du commutateur de réglage de I'unité de réalisation d’écran/
Vérification du capteur inférieur de cadre/Température du thermistor/Vérification de la
tension de la téte d'impression thermique (avant et arriere)/Variables énergétiques de la
réalisation d'écran

Taille du cadre de I'écran
(dimensions extérieures)
(largeur x longueur)

Minimum: 590 mm x 310 mm (23,23" x 12,20")
(épaisseur de cadre de 30 mm (1,18")
Maximum: 635 mm x 914 mm (25,00" x 36,00")

Epaisseur du cadre
de I'écran

20 mm & 45 mm (0,79" &4 1,77")

Capacité de la mémoire

128 MB

Source d’alimentation

CA100-240V,50-60Hz, 36-14A

Consommation Maximum: 300 W

électrique En veille: 50 W ou moins

[()I'_")‘(egs)ﬁ_'?)s Pendant I'utilisation: 1215 mm x 800 mm x 410 mm (47,83" x 31,50" x 16,14")
Espace requis ; " "

(Lx P x H) 1230 mm x 800 mm x 480 mm (48,43" x 31,50" x 18,90")

Poids Env. 71 kg (157 Ib)
Informations relatives | Intérieur, degré de pollution 2%,
a la sécurité A une altitude de 2000 m ou moins

Accessoires

CD-ROM de pilotes
Licence de logiciel de pilotes
Feuillet de protection de la confidentialité

*Le degré de pollution de 'environnement d’utilisation a cause de la saleté et de la poussiere dans l'air. Le
degré “2” correspond a un environnement intérieur courant.

® Remarque

* Veuillez noter qu’en raison des améliorations et des modifications apportées a I'appareil, certaines
images et explications de ce guide peuvent ne pas correspondre a votre machine.

* Les caractéristiques sont susceptibles d’étre modifiées sans préavis.

* Notez que RISO ne pourra étre tenu pour responsable de quoi que ce soit pouvant résulter de I'utili-
sation de ce guide ou de la machine.




~ Notification a 'attention des
Etats membres de I'Union européenne

RISO, I'environnement et la directive relative aux déchets
d'équipements électriques et électroniques (directive DEEE)

Qu'est-ce que la directive DEEE ?
La directive DEEE vise a réduire les déchets et a assurer le recyclage des
équipements électriques et électroniques lorsqu'ils arrivent en fin de vie utile.

hi¢

Que signifie le symbole de la poubelle sur roues barrée ?

Le symbole de la poubelle sur roues barrée indique que ce produit doit étre mis au
rebut indépendamment des déchets courants.

Veuillez contacter votre représentant de service aprés-vente RISO pour obtenir des
informations sur la mise au rebut.

Que signifie le trait plein ?
Le trait plein apparaissant sous la poubelle sur roues barrée indique que ce produit
a été commercialisé apres le 13 aolt 2005.

Qui dois-je contacter pour obtenir plus d'informations sur la
directive DEEE ?

Vous devez contacter votre représentant de service apres-vente local RISO pour
obtenir de plus amples informations.
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Digitaler Siebdrucker
Modell: GOCCOPRO QS2536

Die Verwendung unterliegt der Warnung, dass durch nicht autorisierte und nicht
genehmigte Veranderungen oder Bearbeitungen die Verwendungsbefugnis
erldschen kann.

Achtung

Dieses Produkt entspricht Klasse A. In einer hauslichen Umgebung kdnnte
dieses Produkt Funkstorungen verursachen. In diesem Fall sind entsprechende
Gegenmal3nahmen zu ergreifen.

MASCHINENLARMINFORMATION

Maschinenlarminformations-Verordnung 3. GSGV:
Der héchste Schalldruckpegel betragt 70 dB(A) oder weniger gemé3 EN ISO
7779.

Hinweis:

Das Gerét ist nicht fur die Benutzung am Bildschirmarbeitsplatz gemass
BildscharbV vorgesehen.




Sicherheitsinformationen (De)

Vielen Dank fur den Kauf dieser Maschine.
Diese Maschine ist ein Digitalsiebdrucker, der leicht zu bedienen ist.

Dieses Handbuch enthalt Hinweise flr die grundlegende Bedienung der Maschi-
ne, VorsichtsmaBnahmen bei der Verwendung, Methoden fir den Umgang mit
Verbrauchsmaterialien und eine Anleitung zur Problemldsung.

Lesen Sie das Handbuch sorgfaltig durch, bevor Sie das Gerat in Betrieb neh-
men. Lesen Sie das Handbuch auch, falls Sie Fragen wahrend der Benutzung
haben und wann immer es notwendig ist, damit Sie flr viele Jahre Freude an
Ihrem Gerét haben.

* Microsoft und Windows sind entweder eingetragene Marken oder Marken der
Microsoft Corporation in den Vereinigten Staaten und/oder anderen Landern.

e Mac und Mac OS sind Warenzeichen von Apple Inc.

. 0 QI]@O GOCCOPRO und RISORINC sind Warenzeichen oder eingetra-
gene Warenzeichen der RISO KAGAKU CORPORATION in den Vereinigten
Staaten und anderen Léndern.

e Alle anderen Produkt- und Firmennamen sind eingetragene Warenzeichen
oder Warenzeichen des jeweiligen Unternehmens.

e Die Anzeigen und Inhalte, die in diesem Handbuch aufgefihrt sind, kénnen
vom tatséchlichen Produkt abweichen.

* Die Anzeigen und Meldungen, die in den Verfahren auftauchen, kénnen je nach
Computertyp und Anwendung abweichen (dieses Handbuch benutzt Anzeigen
von Windows 7).

© Copyright 2020 RISO KAGAKU CORPORATION
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Die Bezeichnungen in Diesem Handbuch

Die Bezeichnungen, Zeichen und Terminologie, die in diesem Handbuch verwendet werden, sind unten auf-
gefihrt.

100

Bezeichnung von Seiten, die Beschreibungen der Ablaufe
und Funktionen enthalten

Seiten, die Beschreibungen der Funktionen und Ablaufe enthalten, verwenden folgende Bezeichnungen.
AuBerdem werden die Benennung der Tasten auf dem Bedienfeld und der Knépfe auf dem Computerfens-
ter in eckigen Klammern [ ] angegeben.

‘ Overview ofthis Mactine,

Preparing the Ma

©) O Kapiteliberschrit

ISetting the Screen
Frame

/\Caution

o screen

2 Loosen the Stage Handle to make the

3 Move the Screen Frame Side Guide.

Stage movable.

(2 Betriebsablauf

Ein Betriebsablauf wird in
Schritten beschrieben.

3 Ablaufdarstellung

aaaaaaaaaaa

A

Zeigt einen Teil an, der mit
dem Ablauf zusammenhéangt
wie z. B. die Maschine, das
Bedienungsfeld oder einen
Computerbildschirm.

;“

Verwendete Zeichen in
Diesem Handbuch

/N\ Warning

Eine Warnung in Bezug auf
die Sicherheit.

Fur genauere Angaben
siehe “Warnhinweise” auf

&Caution Seite 12 dieses Hand-
buchs.
Ein wichtiger Punkt, der zu
0 Important|beachten ist, wenn die Ma-

schine bedient wird.

=4

NOTE

Zusatzliche Informationen,
die nutzlich sind, wenn die
Maschine benutzt wird.

Zeigt eine zugehdrige Re-
ferenzseite an.

Verwendete Terminologie in

Diesem Handbuch

Bild- und Textdaten, die auf
einem Computer erstellt wur-
den.

Originaldaten

Das Verfahren zum Lesen von
Originaldaten, die von einem
Computer an die Maschine

Siebdruck gesendet werden, und dem
entsprechenden Perforieren
eines Screenmasters.

Der Anfangswert jeder Ein-
Standardwert stellung unmittelbar nach

dem die Maschine einge-
schaltet wurde.

Hinweis zu den
Computerbildschirmen

Die Art und Weise wie Dialogfelder, usw. ange-
zeigt werden, kann je nach verwendeter Version
des Betriebssystems von jener, die in diesem
Handbuch abgebildet ist, abweichen.
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Sicherheitshinweise

Dieser Abschnitt enthélt Sicherheitsinformationen, die vor dem Gebrauch des Gerates zu beachten sind.
Lesen Sie diesen Abschnitt aufmerksam durch, bevor Sie dieses Gerét verwenden.

IWarnhlnwelse INetzanscthss
Die folgenden Warnhinweise dienen der Sicher-
stellung eines sachgerechten Gerétebetriebes .
und sollen Personengefahrdungen sowie Sach- &Warnlng
schéden verhindern.  Das mitgelieferte Netzkabel ist fir dieses Ge-

rat bestimmt. Verwenden Sie es nicht fur an-
dere Elektrogerate. Andernfalls kdnnen Feu-
er oder elektrischer Schlag die Folge sein.

Vergewissern Sie sich, dass sie den Inhalt voll-
standig verstehen, bevor Sie mit dem Haupttext

fortfahren.
: ¢ Verwenden Sie das Stromkabel nicht im zu-
Kennzeichnet, dass sammengebundenen oder aufgewickelten
falsche Handhabung | Zustand, um zu vermeiden, dass das Kabel
AWarning gggcgyr*%g?gigaegchwgz sich aufheizt. unq Feuer.féngt.
ren oder tdlichen Ver- * Verwenden Sie keine Zweig- oder ﬁ
| . Mehrfachsteckdosen. Andernfalls
etzungen fuhren kann. : R .
i kdnnen Feuer oder elektrischer
Kennzeichnet, dass Schlag die Folge sein.
falsche Handhabung |
P durch Ignorierendieses | « Das Netzkabel darf nicht ange-
&Cautlon Symbols zu Verletzun- | kratzt, beschadigt oder manipu- %
?Ui?e%dsgff(:h%haden liert werden. Keine schweren
: g Gegenstande auf das Netzka-

bel stellen und nicht verziehen
oder verbiegen, da es sonst be-

I Aufstell t schéadigt werden kann. Andern-
urste Ungsor falls kénnen Feuer oder elektri-
scher Schlag die Folge sein.
&Caution * Das Netzkabel darf nicht mit nassen Han-
den angefasst werden. Andernfalls kann
e Stellen Sie dieses Gerat nicht auf instabi- elektrischer Schlag die Folge sein.

len, wakkeligen oder schréagen Flachen auf.
Wenn dieses Gerat herunterfallt oder um- :
kippt, kdnnen Verletzungen die Folge sein. ACaution

* Stellen Sie das Gerat nicht in feuchten oder :
staubigen Umgebungen auf. Andernfalls
kann Feuer oder elektrischer Schlag die
Folge sein.

¢ Diese Maschine ist nicht fiir den Gebrauch
durch Kinder geeignet. Verwenden Sie die
Maschine an einem Ort, der Kindern nicht
zugénglich ist.

¢ Beim Trennen nicht das Netzkabel ziehen,
sondern das Netzkabel am Stecker fest-
halten. Andernfalls kann das Netzkabel be-
schéadigt werden, was zu Feuer oder einem
elektrischen Schlag fuhren kann.

¢ Wenn dieses Gerat langere Zeit nicht ver-
wendet wird, z. B. Uber mehrere Feiertage,
trennen Sie das Netzkabel fir eine erhdhte
Sicherheit.

¢ Trennen Sie das Netzkabel mindestens ein-
mal pro Jahr von der Steckdose und reini-
gen Sie die Stekkerstifte sowie deren Um-
gebung. Staub, der sich in diesen Bereichen
ansammelt, kann einen Brand verursachen.
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I Erdungsanschluss I Geratehandhabung
/N\ Warning | /N\ Warning

¢ Bitte achten Sie darauf, dass

102

Sie den Stecker mit dem Er-
dungsleiter in eine Steckdose
mit einem Erdungsanschluss
einstecken. Wenn die Maschi-
ne nicht geerdet ist, kann es zu
einem Kurzschluss kommen.
Andernfalls kbnnen Feuer oder
elektrischer Schlag die Folge
sein.

* Keine mit Flussigkeiten gefillte Behalter auf
dieses Gerét stellen und auch keine Metall-
gegenstande darauf ablegen. Wenn Wasser
in das Geréat eindringt oder Metallgegen-
stdnde hineinfallen, kann es zu Feuer oder
einem elektrischen Schlag kommen.

* In der Nahe dieses Gerates keine feuer-
geféhrlichen Sprays und entflammbare L6-
sungsmittel verwenden. Wenn versprihte
Gase oder entflammbare Lésungsmittel mit
elektrischen Teilen im Innern des mechani-
schen Systems in Kontakt kommen, besteht
Brand- und Elektroschockgefahr.

* Keine Fremdkérper, wie z. B. Metallteile oder
hoch entflammbare Teile, durch eine Gera-
tedffnung in dieses Gerat einfihren oder hi-
neinfallen lassen. Andernfalls kénnen Feuer
oder elektrischer Schlag die Folge sein.

* Die Abdeckungen dieses Gerétes nicht ab-
nehmen. Durch Abnehmen der Abdeckun-
gen kann es zu einem elektrischen Schlag
kommen.

¢ Nicht versuchen, dieses Gerat @
zu zerlegen oder zu modifizie-
ren. Andernfalls kébnnen Feuer \3
oder elektrischer Schlag die
Folge sein.

* Der Thermokopf und die umge-
benden Metallteile sind heif3,
wenn das Geréat eingeschaltet
ist oder kurz nachdem es aus-
geschaltet ist. Berlihren Sie
die Teile nicht, um zu vermei-
den, dass Sie sich verbrennen.
Wenn Sie die Maschine reini-
gen, warten Sie, bis sie sich
abgekuhlt hat.

e Lassen Sie eine fremde Person, die nicht
weil3, wie sie die Maschine zu verwenden
hat, diese nicht berlGhren. Dies kann durch
die BerUhrung der gefahrlichen Teile oder
das unerwartete Starten der Maschine zu
einem Unfall fGhren.
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Klemmen Sie sich lhre

/N\Warning Hinde oder Arme nicht ein

e Sollte das Gerat GbermaBige
Hitze, Rauch oder Ublen Ge-
ruch entwickeln, sofort den
Hauptschalter  ausschalten,
das Netzkabel trennen und
den Handler oder autorisierten
Servicepartner versténdigen.
Andernfalls kann Feuer oder
elektrischer Schlag die Folge
sein. Weitere Informationen er-
halten Sie von lhrem Fach-
handler oder autorisierten
Servicepartner.

* Sollte ein Fremdkérper in das
Gerat gelangen, sofort den
Hauptschalter  ausschalten,
das Netzkabel trennen und
den Héandler oder autorisierten
Servicepartner versténdigen.
Wenn Sie das Geréat ohne ge-
eignete MaBnahmen weiter-
verwenden, besteht Brando-
der Stromschlaggefahr.

/N\ Caution

» Stecken Sie niemals lhre Finger in eine Off-
nung usw. dieser Maschine. Es kann zu Ver-
letzungen fuhren.

e Wenn Sie die Maschine anheben oder
transportieren, halten Sie stets die Unter-
seite des Hauptgeréats fest. Wenn Sie nur
den oberen Teil des Hauptgerats festhalten,
kann dies dazu fiihren, dass es herunter-
fallt, und eine Verletzung verursacht.

* Die Maschine wiegt etwa 71 kg. Ergreifen
Sie bei der Verpackung, Installation und
beim Transport der Maschine die entspre-
chenden VorsichtsmafBnahmen.

Der Warnaufkleber
weist auf die Mog-
lichkeit einer Verlet-
zung hin, wenn lhre
Hand oder |hr Arm
in einer Abdeckung
oder einem Ein-
schubschacht einge-
klemmt wird usw.

® Stecken Sie Ihre Hande nicht in das Gerét
und achten Sie darauf, dass sich Ihre Klei-
dung nicht verfangt, wenn sich die Siebdru-
ckeinheit bewegt. Dies kann zu einer Verlet-

zung fahren.
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I Warnsymbole

Aus Sicherheitsgrinden ist dieses Gerat mit dem unten angegebenen Warnsymbol versehen. Wenn Sie mit
diesem Gerat arbeiten oder dieses Geréat warten, lesen Sie bitte die Hinweise auf dem Warnsymbol, das
eine sichere Benutzung des Geréts gewéhrleistet.

Entfernen Sie das Warnsymbol nicht und achten Sie darauf, dass es nicht beschmutzt wird. Sollte das
Warnsymbol vom Gerét abfallen, die Schrift ausgeblichen oder nicht mehr leserlich sein, wenden Sie sich
an Ihren Handler oder eine autorisierte Kundendienstvertretung.

Platzierung der Warnsymbole

Die Platzierungen der Warnsymbole werden wie folgt gezeigt:

Vorder-/Unterseite

Warnaufkleber fiir den Thermodruckkopf

Since the Thermal Print
Head is very delicate,
avoid shocks or
scratches with a hard
object.

118-28060-009

Riick-/Oberseite

Warnaufkleber

118-28059-000

Inhalt des Warnaufklebers fir den Thermodruckkopf

Der durch diesen Aufkleber angegebene Ort (Thermodruckkopf) ist sehr hei3. Da der Thermodruckkopf
sehr empfindlich ist, vermeiden Sie St63e oder Kratzer mit einem harten Gegenstand.

Inhalt des Warnaufklebers

Der Warnaufkleber weist auf die Mdéglichkeit einer Verletzung hin, wenn lhre Hand oder lhr Arm einge-
klemmt wird, wahrend sich die Siebdruckeinheit bewegt.
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Vor Inbetriebnahme

® Folgende Umgebungsbedin-

I Sicherheitshinweise zur

Aufstellung
Aufstellungsort

® Der Aufstellungsort dieses Gerates wird in
Absprache mit lhnen bei der Lieferung be-
stimmt.

® Der Aufstellungsort fur dieses Geréat sollte
permanent sein. Wenn Sie das Gerat be-
wegen modchten, wenden Sie sich an lhren
Handler oder autorisierten Servicepartner.

® Stellen Sie dieses Gerat nicht an einer der
folgenden Stellen auf: Nichtbeachtung dieser
VorsichtsmafBregel kann zu Funktionsstérun-
gen, Ausfall oder Unféllen flhren.

* Stellen mit direkter Sonne-
neinstrahlung und Stellen in
Fensterndhe (an die Fens-
ter bei Bedarf Vorhéange an-
bringen)

* Stellen, die plétzlichen Temperaturdnde-
rungen ausgesetzt sind

» Extrem warme und feuchte sowie kalte und
trockene Stellen

* Stellen in der Nahe von Feuer oder Hitze,
direkter Kaltluft (z. B. Klimaanlagen), direk-
ter HeiBluft (z. B. Heizgeréate) oder Warme-
Ubertragungen

* Abgeschlossene Raume mit schlechter
Laftung

 Staubige Orte

* Orte ohne ausreichende Tragkraft wie zum
Beispiel der Arbeitstisch

Hinweise zur
Betriebsumgebung

® |[nstallieren Sie die Maschine an einer ebenen
Stelle,diefolgenden Anforderungenentspricht.
(Ebenheit fur die Aufstellung: maximal 10 mm
in der Lange und Breite)

EinstellfiiBe P S. 22

gungen sind geeignet.

e Temperaturbereich:
15 °C bis 30 °C

* Relative Luftfeuchtigkeit:
40 % bis 70 %
(nicht kondensierend)

Erforderlicher Platz

Fur dieses Gerat ist der folgende Raum erfor-
derlich.

‘EIEIII. Einheit: mm

1230
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VorsichtsmaBnahmen
beim AnschlieBBen

VorsichtsmaBnahmen beim
AnschlieBen der
Stromversorgung

® Achten Sie darauf, dass das
Netzkabel sicher mit der
Steckdose verbunden ist, um
einen schlechten Netzste-
ckerkontakt zu vermeiden.

® Stellen Sie dieses Gerat in der Nahe einer
Steckdose auf.

Der Druckertreiber

Dieser Druckertreiber ist fiir die Ubertragung der
Originaldaten von lhrem Computer und die Er-
stellung der Siebdrucke ausgelegt.

Der Druckertreiber befindet sich auf der beige-
figten CD-ROM. Wenn Sie das erste Mal eine
Siebdruckvorlage erstellen, missen Sie den
Druckertreiber installieren.

VorsichtsmaBnahmen bei
der Verbindung mit einem
Computer

® Bevor Sie die Maschine verwenden, missen
Sie den Druckertreiber von der beigefligten
CD-ROM installieren.

@ 'mportant

SchlieBen Sie die Maschine nicht an den Compu-
ter an, bevor Sie den Druckertreiber installieren.

® Diese Maschine muss Uber ein handelstbli-
ches USB-Kabel (weniger als 3 m, kompati-
bel mit Highspeed-USB) an einem Computer
angeschlossen werden.

® Die hodchstzulassige Spannung flr einen
USB-Anschluss betragt 5 V.

I Sicherheitshinweise fur
~ den Gebrauch
Behandlung

Diese Maschine ist eine Prazisionsmaschine.
Stellen Sie keine schweren Gegensténde auf
die Maschine und Uiben Sie keine StdRe oder
starken Kréafte auf sie aus.

Stecken Sie Ihre Finger oder Hande nicht in
den Thermokopf und die beweglichen Teile.

Bewegen Sie die Siebdruckeinheit nicht mit
Ihren Handen. Verwenden Sie den Benutze-
reinstellungsmodus, um die Siebdruckeinheit
in die Mitte zu bewegen.

Wéhrend des Betriebes das Netzkabel nicht
trennen oder die Stromversorgung ausschal-
ten.

Verschieben Sie den Siebrahmen nicht und
bewegen Sie die Maschine nicht, wahrend
die Maschine lauft.

Offnen Sie die Siebdruckeinheit nicht, wenn
sie lauft.

Dieses Gerat enthalt Prazisionsteile und Pra-
zisionsantriebsmechanismen. Flhren Sie
ausschlieBlich die in dieser Anleitung be-
schriebenen Verfahren aus.

Reinigen Sie die Maschine regelmafig. Wenn
sich Fremdkorper auf einem Sieb befinden,
wird der Thermokopf beschadigt. Verwen-
den Sie keine leichtldslichen organischen
Lésungsmittel wie zum Beispiel Verdlinnung
oder Waschbenzin zur Reinigung. Bei deren
Verwendung kann die Beschichtung abblat-
tern, dadurch kénnen Fehler auftreten. Ver-
wenden Sie zur Reinigung ein neutrales Rei-
nigungsmittel.

Verwenden Sie fur die Maschine die vorgese-
hene RISO Digital Screen Master und RISO
DIGITAL SCREEN QS MASTER. Wenn Sie
andere Siebdruckeinheiten verwenden, kann
die Qualitat nicht garantiert werden.

Siebdruckvorlage P S. 78
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Aufbewahrung der
Siebdruckvorlage

Bewahren Sie diese Teile nicht an einer der fol-
genden Stellen auf:

 Stellen mit direkter Sonne-
neinstrahlung und Stellen in
Fensterndhe (an die Fens-
ter bei Bedarf Vorhénge an-
bringen)
 Stellen, die plotzlichen Temperaturande-
rungen ausgesetzt sind

e Extrem warme und feuchte sowie kalte und
trockene Stellen

I Materialien, die nicht

bedruckt werden durfen

Verwenden Sie diese Gerat ausschlieBlich ge-
mani den gesetzlichen Bestimmungen und den
bestehenden Urheberrechten (Copyrights),
auch dann, wenn Sie Kopien fir den persénli-
chen Gebrauch erstellen. Im Zweifelsfall wen-
den Sie sich an die 6rtlichen Behoérden. Seien
Sie diskret und handeln Sie nach gesundem
Menschenverstand.
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Merkmale dieser Maschine

Diese Maschine ist ein Digitalsiebdrucker, der ausschlieBlich fiir den RISO Digital Screen Masters konzipiert ist. Setzen Sie ein Sieb in den Siebdruck-
rahmen ein und legen Sie ihn auf die Maschine, um einen Siebdruck durchzufihren. Dieses Handbuch beschreibt den Vorgang bis “3. Siebdruck’”.

IVorgang vom Siebdruck bis zum Bedrucken

— Installieren Sie den “RISO-GOCCO- @ Ubertragen Sie die Originaldaten.
m = PRO-Druckertreiber” auf Ihrem Com- (@))] |
3 puter. Y
o P & Print!
@, | . a
> [ g
o = S o
@ .
E O :m r | 110 II rir
> 5 l AR
Q
B | o orh oo, (0 Senden der Originaldaten:
Fur Windows P> S. 42
Installationsvorgang: Fur Mac OS » S. 50

Fur Windows » S. 35

Fir Mac OS > S. 38 Der Siebdruck startet.

Legen Sie den Siebdruckrahmen auf die Maschine.

Der Siebdruck ist abgeschlossen.
Einstellungen des Siebdruckrahmens P S. 30

SchlieBen Sie die Maschine mit einem
USB-Kabel an den Computer an, und schal-
o \

ten Sie den Netzschalter der Maschine an.

SYONJpgals sep 6un1!eJquO/\ e

Bedrucken Sie mit der fur das Material und
den Verwendungszweck geeigneten Tinte.

uayonIpag ‘v

Kabelverbindung und Stromversorgung
» S.32
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I Prufpunkte flir den Betrieb

¢ Registrierung der SiebdruckrahmengroBe

Legen Sie voher den zu verwendenden Siebdruckrahmen fest. Sie konnen in der [Vorschau] des Druckertreibers in
' einer Vorschau prifen, wie das Bild auf das Sieb Uber-

— tragen wird, bevor Sie den Siebdruck durchfiihren.
Width: 250 ] [ac o) :
[23.23 - 25.00] - . . . . " .
o 00 o : ¢ Befindet sich das Bild innerhalb des Bildbereichs?
[12.20 - 36.00; B
- * Ist die Bildorientierung richtig?
[ ( _ Add ] :
. Bildschirm-Rahmengré3e (Rahmenbreite)
[ woew ]
[ Move Dow ]
Import ( Export ]
Close

SiebdruckrahmengréBe » S. 25

Bildschirm-Rahmengré3e (Rahmenlange

Vorne m
Q
Registrierung der Siebdruckrahmengré3e E
(Windows) > S. 43 g
E
i
® Einstellung des Druckertreibers !
Die Siebdruckausflihrung kann geman dem zu (iber- Rahmenstarke =
tragendem Bild, dem zu bedruckenden Material und ;
der zu verwendenden Tinte vorgegeben werden. Die Details zum Bildbereich und zur Bildorientierung wer-
' den an anderer Stelle in diesem Handbuch beschrieben.
© i z
- . Informationen tiber den Siebdruck > S. 25
= e :
B - e — I . . I
= = ~ IMaschinenfunktionalitat
—— | e Die Maschine ermdglicht feinen Text und Abstufun-

gen, die mit einer hohen Préazision durch hochauf-
I6sende Perforation bei 600 dpi (Perforationsdichte

Einstellung der Siebdruckrahmengroie 1200 dpi) x 1200 dpi wiedergegeben zu werden.

(Windows) » S. 46
(Bild)

Registrierung des Bildbereichs
(Mac OS) »> S. 51

Einstellung des Siebdruckverfahrens: »

Fur Windows » S. 46
Fir Mac OS » S. 54

Einstellung der Siebdruckausfiihrung: _ _
Fur Windows P S. 48 600 dpi 1200 dpi
Fir Mac OS » S. 55 %

Je nach der Medienart ist moglicherweise eine spezielle
Aufbereitung erforderlich.
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Technische Daten

110

GOCCOPRO QS2536

Siebdruckverfahren

Highspeed-Digitalsiebdruck

Siebdruck Zeit

Ca. 200 Sek. (A2 (420 mm x 594 mm) BildbereichgréBe)

BildbereichgréiBe

Minimum: 10 mm (Breite) x 10 mm (Lange)
Maximum: 457 mm (Breite) x 759 mm (Lange) (mit einer Rahmenstarke von 20 mm)
455 mm (Breite) x 734 mm (Lange) (mit einer Rahmenstarke von 45 mm)

Auflésung

600 dpi (Perforationsdichte: 1200 dpi) x 1200 dpi

Bedienfeld

Harzgeformte Tasten / Abschnitt 7 Anzeige

Schreibstartposition

90 + 2 mm von der Oberkante

Rand

45 mm oder mehr an der Unterseite
45 mm oder mehr auf der Vorderseite, 45 mm oder mehr auf der Rlckseite

Siebdruck
Positionsgenauigkeit

+ 0.5 mm oder weniger (Positionsgenauigkeit bei wiederholtem Siebdruck)

Benutzerdefinierter
Einstellmodus

Piepton / Screenmaster Zahler (Nr. der Siebe) / Bild VergréBerung / Verkleine-
rung / Testdruck (Kontrolle, Gitter, oder schwarze Mittellinie) / Automatischer
Siebdruck Wechsel / Zentrierung der Siebdruckeinheit / Anzeigen der Versions-
informationen / Screenmaster Sensorprifung / Siebdruck Drucksensorpruifung /
Siebdruckgerat Schaltkontrolle / Unterrahmen Sensorprifung / Temperaturfihler
Temperatur / TPH Spannungsprufung (Vorder- und Rickseite) / Siebdruck-Ener-
gievariablen

SiebrahmengréBe

Minimum: 590 mm (Breite) x 310 mm (L&nge) (mit einer Rahmenstarke von 30 mm)

(AuBenabmessungen) | Maximum: 635 mm (Breite) x 914 mm (Lange)
Siebrahmenstéarke |20 mm bis 45 mm
Speicherkapazitat | 128 MB

Strom-Quelle

Wechselstrom 100 - 240V, 50-60Hz, 3,6 - 1,4 A

Energieverbrauch

Maximum: 300 W
Im Ruhezustand: 50 W oder weniger

MaBe Im Gebrauch: 1215 mm (B) x 800 mm (T) x 410 mm (H)
Erforderlicher Raum | 1230 mm (B) x 800 mm (T) x 480 mm (H)
Gewicht Ca. 71 kg
Sicherheits- Innenraum, Verschmutzungsgrad 2%,
Informationen Bei H6henlagen von 2000 m oder niedriger
Treiber-CD-ROM
Zubehor Treiber EULA

Datenschutzblatt

*Der Verschmutzungsgrad der Arbeitsumgebung durch Schmutz und Staub in der Luft. Grad “2” entspricht
einer normalen Innenraumumgebung.

® Hinweis

* Bitte beachten Sie, dass auf Grund von Verbesserungen und Verdnderungen an der Maschine einige
Bilder und Erklarungen in diesem Handbuch nicht Ihrer Maschine entsprechen kénnten.

« Technische Anderungen ohne vorherige Bekanntmachung vorbehalten.

* Beachten Sie, dass RISO nicht fur irgendwelche Schéaden verantwortlich gemacht werden kann, die
durch das Benutzen des Handbuchs oder der Maschine verursacht werden.




Hinweis fiir Mitgliedstaaten der
Europaischen Union

RISO, die Umwelt und die Verordnung liber Elektro- und
Elektronik-Altgerdte (WEEE-Verordnung)

Was ist die WEEE-Verordnung?
Die WEEE-Verordnung soll Abfall reduzieren und sicherstellen, dass elektrische und
elektronische Gerate am Ende ihrer Nutzungsdauer wiederverwertet werden.

hi¢

Was bedeutet das Symbol einer durchgestrichenen Abfalltonne

auf Radern?

Das Symbol einer durchgestrichenen Abfalltonne auf Radern bedeutet, dass dieses
Produkt vom normalen Mull getrennt gesammelt werden muss.

Bitte wenden Sie sich an Ihren RISO-Kundendienst fir weitere Informationen tber
die Entsorgung.

Was bedeutet das Balkensymbol?
Der Balken unter der durchgestrichenen Abfalltonne auf Radern bedeutet, dass
dieses Produkt nach dem 13. August 2005 auf den Markt gebracht worden ist.

An wen kann ich mich wenden, wenn ich mehr lber die

WEEE-Verordnung wissen méchte?
Fir weitere Informationen sollten Sie sich an lhren ortlichen RISO-Kundendienst
wenden.

RISO KAGAKU CORPORATION LONDON OFFICE
Avda. de les Garrigues, 38-44 planta 2a local B1 08820 Prat de Llobregat - Barcelona, Spain
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Quadro serigrafico digitale
Modello: GOCCOPRO QS2536

Luso & subordinato al fatto che cambiamenti o modifiche non autorizzati
possono inficiare la liberta dell’utente di utilizzare 'attrezzatura.

Avvertenza

Il presente apparecchio € di classe A. Utilizzato in aree residenziali, il presente
apparecchio puo causare interferenza radio. In tal caso, I'utente potrebbe
essere tenuto ad adottare adeguate misure correttive.




Informazioni sulla sicurezza (It)

Grazie per aver acquistato questo macchinario.
Questo & uno screen maker digitale facile da utilizzare.

Questa guida contiene le istruzioni di base per il funzionamento del macchina-
rio, le precauzioni per 'uso, i metodi per la gestione dei materiali di consumo e
una guida per la risoluzione dei problemi.

Leggere attentamente questa guida prima di utilizzare il macchinario. Leggere
questa guida anche quando si hanno dei dubbi durante I'uso ed ogni volta che &
necessario, e utilizzarla per molti anni.

* Microsoft e Windows sono marchi di fabbrica o marchi di fabbrica registrati di
Microsoft Corporation negli Stati Uniti e/o in altri Paesi.

e Mac e Mac OS sono marchi di fabbrica di Apple Inc.

. 0 Q[l@O GOCCOPRO e RISORINC sono marchi o marchi registrati di
RISO KAGAKU CORPORATION negli Stati Uniti e in altri Paesi.

e Tutti gli altri nomi dei prodotti e i nomi aziendali sono marchi di fabbrica o marchi
di fabbrica registrati di ciascuna societa, rispettivamente.

¢ Le schermate e i contenuti che appaiono in questo manuale potrebbero differire
dal prodotto reale.

* Le schermate e i messaggi che appaiono nelle procedure potrebbero differire a
seconda del tipo di computer e dell’applicazione (in questa guida sono utilizzate
schermate di Windows 7).

© Copyright 2020 RISO KAGAKU CORPORATION
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Notazione a questa guida

La notazione, i simboli e la terminologia utilizzati in questa guida sono indicati di seguito.

Notazione di pagine contenenti descrizioni delle operazioni e
delle funzioni

Pagine contenenti descrizioni delle funzioni e delle operazioni utilizzano la seguente notazione. Inoltre, i
nomi dei tasti fissi sul pannello operativo e dei tasti sulle finestre del computer sono indicati con parentesi
quadre [ ].

O} Ty | —— @ Titolo del capitolo

+ s — @ Procedura operativa

+ attached against the 2 Screen the directon of the scroen frame, tighton
‘ Rotainers and Scroen Framo Side. the Stage Handlo (x2).

ISetling the Screen
Frame

217

Una procedura operativa vie-
ne descritta in varie fasi.

2 Loosen the Stage Handle to make the
Stage movable.

@ Illlustrazione del funziona-

> @ 'mportant
%ﬁ i\’\ mento
T H H Mostra una parte correlata al
3 Move the Screen Frame Side Guide
toward yoursell. [N Screen Frame Retainer b P.23

funzionamento, ad esempio
il macchinario, il pannello di
controllo o il display del com-

i "

Sido Guide.

7' Move the Stage while holding down the
he

== puter.
\ \
Simboli utilizzati in questa =~ Terminologia utilizzata in
guida ~questa guida
: Una precauzione relativa . |l dati di immagine e di testo
&Warnlng alla sicurezza. Dati eriginali | ¢, o2t su un Co?nputer.
Per i dettagli, fare riferi-|
mento a ‘Indicazioni di Il processo di lettura dei dati

&Caution avvertenza” a pagina 12 di
questa guida.

originali inviati da un compu-
ter al macchinario e perfora-
zione di uno screen master.

[l valore iniziale di ciascuna

Screen making

Un punto importante da
Olmportant osservare quando il mac-

chinario & in funzione. Valo_re_ impo.stazione. sgbitc? dopo
: predefinito |che il macchinario viene ac-
Informazioni supplementa- Ceso.
Q ri utili all’utilizzo del mac-|
NoTE chinario.

~ Notarelativa alle schermate
Indica una pagina di riferi- del computer

mento relativa.

Il modo in cui le finestre di dialogo, ecc. vengo-
no visualizzate puo differire dal modo indicato
in questa guida, a seconda della versione del
sistema operativo in uso sul computer.
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Precauzioni in materia di sicurezza

Questa sezione descrive le informazioni da conoscere prima di utilizzare la macchina. Leggere questa sezio-

ne prima di utilizzare la macchina.

Ilndicazioni di avvertenza

Le seguenti indicazioni di avvertenza sono in-
tese a garantire 'adeguato funzionamento della
macchina, nonché ad evitare rischi di lesioni fisi-
che o di danni materiali.

Assicurarsi di comprendere bene il contenuto
prima di procedere al testo principale.

Indica che una mani-
polazione non corretta,
AWarning che ignori questo sim-
bolo, pud provocare le-
sioni gravi o mortali.

Indica che una mani-
polazione non corretta,

. che ignori questo sim-
&Cautlon bolo, pud provocare
lesioni fisiche o danni
materiali.

IAmbiente di installazione

/N\ Caution

* Non collocare la macchina in una posizione
instabile, su una base malferma o una su-
perficie inclinata. La caduta o il ribaltamento
della macchina possono provocare lesioni
fisiche.

e La macchina non deve trovarsi in prossimita
di ambienti umidi e polverosi. Il mancato ri-
spetto di questa precauzione puo dar luogo
ad incendi o scosse elettriche.

* Questa macchina non & adatta per I'uso da
parte dei bambini. Utilizzare la macchina in
un luogo non accessibile da parte dei bam-
bini.

| Allacciamento alla rete

/N\ Warning

¢ |l cavo di alimentazione fornito & specifica-
mente adatto a questa macchina. Non uti-
lizzarlo con altre apparecchiature elettriche.
Vi ¢ il rischio di incendi o scosse elettriche.

* Non utilizzare il cavo di alimentazione in-
trecciato con altri cavi per evitare il riscalda-
mento che potrebbe portare ad un incendio.

* Non utilizzare prese con deri-
vazioni o ramificazioni o prese ﬁ
multiple. Vi & il rischio di incen-
di o scosse elettriche.

* Non graffiare, danneggiare o
trasformare il cavo di alimenta-
zione. Non danneggiare il cavo

di alimentazione collocandolo

sotto oggetti pesanti, tirando-

lo o piegandolo con forza. Vi

e il rischio di incendi o scosse

elettriche.

* Non inserire o disinserire la spina con le
mani bagnate. Si rischiano scosse elettri-
che.

/N\ Caution

* Per staccare la spina, non tirare il cavo di
alimentazione (ma afferrare la spina). Si
rischia di danneggiare il cavo, con conse-
guente rischio di incendi o scosse elettriche.

» Se si prevede di non utilizzare la macchina
per periodi prolungati, in previsione di va-
canze, ecc., non dimenticare di staccare la
spina del cavo di alimentazione, onde ga-
rantire la sicurezza.

e Staccare il cavo di alimentazione almeno
una volta I'anno e pulire i poli della spina e la
zona ad essi circostante. Laccumulo di pol-
vere in questi punti pud provocare incendi.
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| Messa a terra I Manipolazione della

macchina

/N\ Warning

 Assicurarsi di inserire la spina

116

di alimentazione con un con-
duttore di terra nella presa a
muro con una messa a terra.
Se la macchina non é collega-
ta alla messa a terra, potrebbe
verificarsi un corto circuito. Vi
e il rischio di incendi o scosse
elettriche.

/N\ Warning

* Non poggiare sulla macchina recipienti con-
tenenti acqua o oggetti metallici. La penetra-
zione di acqua o di oggetti metallici all'inter-
no della macchina puo provocare incendi o
scosse elettriche.

* Non spruzzare prodotti combustibili, né uti-
lizzare solventi infiammabili in prossimita
della macchina. Il contatto tra gas spruzzato
o solvente infiammabile con i componenti
elettrici allinterno del sistema meccanico
puod provocare incendi o scosse elettriche.

* Non inserire o lasciar cadere corpi estranei
come oggetti metallici o sostanze altamente
combustibili in nessuna delle aperture della
macchina. Vi & il rischio di incendi o scosse
elettriche.

* Non rimuovere gli sportelli della macchina.
La rimozione degli sportelli comporta il ri-
schio di scosse elettriche.

* Non smontare, né modificare @
la macchina. Vi € il rischio di ‘
incendi 0 scosse elettriche.
e La testina termica e le par-
ti metalliche circostanti sono
molto calde quando la mac-
china & accesa o subito dopo
lo spegnimento. Non toccarle
per evitare ustioni. Quando si

pulisce la macchina, attendere
finché non si & raffreddata.

* Non consentire a persone che non sanno
come utilizzare la macchina di toccarle. Toc-
care parti pericolose o avviare la macchina
in modo involontario potrebbe causare un
incidente imprevisto.
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/N\ Warning

¢ Se la macchina dovesse surri-
scaldarsi o emettere fumo o
cattivo odore, spegnerla im-
mediatamente, staccare la spi-
na del cavo di alimentazione
dalla presa e rivolgersi al con-
cessionario o al servizio assi-
stenza autorizzato. || mancato
rispetto di questa precauzione
pud dar luogo ad incendi o
scosse elettriche. Per ulteriori
informazioni, rivolgersi al con-
cessionario o al servizio assi-
stenza autorizzato.

* In caso di penetrazione di
un corpo estraneo allinter-
no della macchina, spegnere
immediatamente linterrutto-
re di alimentazione dell'unita
principale, staccare la spina
del cavo di alimentazione e
rivolgersi al concessionario o
al servizio assistenza autoriz-
zato. Continuare ad utilizzare
la macchina senza adottare le
misure adeguate comporta il
rischio d’'incendi o scosse elet-
triche.

/\ Caution

* Non posizionare mai le dita in un’apertura,
ecc. di questa macchina. Vi ¢ il rischio di fe-
rirsi.

* Per sollevare o spostare la macchina, assi-
curarsi di reggere la parte inferiore dell’uni-
ta principale. Mantenere la parte superiore
dell’'unita principale potrebbe provocarne la
caduta e causare lesioni.

* La macchina pesa circa 71 kg. Prendere le do-

vute precauzioni quando si imballa, si installa o
si sposta la macchina.

Evitare di rimanere incastrati
con le mani o le braccia

Letichetta di avver-
tenza indica la possi-
bilita di lesioni causa-
te dalle mani o dalle
braccia incastrate in
un coperchio 0 in una
fessura di inserimen-
to, ecc.

® Non inserire le mani o lasciare che i vestiti ri-
mangano incastrati quando il quadro serigra-
fico & in movimento. Cid comporta il rischio
di lesioni.
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Etichetta di avvertenza

Per motivi di sicurezza, I'etichetta di avvertenza & apposta su questa unita. Durante il funzionamento o la
manutenzione dell’'unita, leggere le istruzioni sull’etichetta di avvertenza per garantire la sicurezza.

Non rimuovere o sporcare I'etichetta. Se I'etichetta non & posta sull’unita, & staccata o non leggibile, con-
tattare il proprio concessionario o il rappresentante autorizzato.

Posizione dell’etichetta di avvertenza

Le posizioni delle etichette di avvertenza (pericolo) sono indicate di seguito.

Lato anteriore/inferiore

Etichetta di avvertenza della testina
di stampa termica

Since the Thermal Print
Head is very delicate,
avoid shocks or
scratches with a hard
object.

118-28060-009

Lato posteriore/superiore

Etichetta di avvertenza

118-28059-000

Contenuto dell’etichetta di avvertenza della testina di stampa
termica

La posizione indicata da questa etichetta (testina di stampa termica) raggiunge temperature elevate. Poi-
ché la testina di stampa termica & molto delicata, evitare di urtarla o graffiarla con un oggetto duro.

Contenuto dell’etichetta di avvertenza

Letichetta di avvertenza indica la possibilita di lesioni causate dalle mani o dalle braccia incastrate mentre
il quadro serigrafico & in movimento.
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Prima dell’'uso

I Precauzioni relative
all’installazione

Ambiente di installazione

® |l luogo in cui installare la macchina sara de-
terminato insieme all’'utente al momento della
consegna.

® |l luogo dinstallazione della macchina deve
essere fisso. Qualora si preveda di spostare
la macchina, rivolgersi al concessionario o al
servizio assistenza autorizzato.

® Non installare la macchina negli ambienti sot-
to elencati. Il mancato rispetto di questa pre-
cauzione pu0 provocare problemi di funzio-
namento, guasti o incidenti.

* Ambienti direttamente
esposti alla luce solare di-
retta, come ad esempio
vicino ad una finestra (se
necessario, munire di tende
le finestre)

* Ambienti soggetti a improvvisi sbalzi di
temperatura

* Ambienti estremamente caldi e umidi oppu-
re freddi e secchi

* Ambienti esposti a fuoco o calore, a flussi
diretti di aria fredda (condizionatore d’aria)
o di aria calda (impianto di riscaldamento),
oppure a calore trasmesso

* Ambienti scarsamente aerati e ventilati
* Luoghi polverosi

¢ Posizioni senza forza sufficiente come un
tavolo da lavoro

Note sull’ambiente di
funzionamento

® |[nstallare la macchina in un luogo il cui li-
vello rientri nel seguente intervallo.
(dislivello massimo ammesso: 10 mm, sia in
lunghezza che in larghezza)

Piedini di regolazione P P. 22

® e condizioni ambientali adatte
sono le seguenti.

* Fascia di temperatura:
da15°Ca30°C

* Fascia di umidita:
dal 40 % al 70 %
(senza condensa)

Spazio necessario

La macchina richiede lo spazio seguente.

Unita: mm

1230

Anteriore

480
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I Precauzioni relative al
collegamento
Precauzioni relative al

collegamento
dell’alimentazione

® Fare attenzione ad inserire
fino in fondo la spina del cavo
di alimentazione nella presa.

® Collocare la macchina vicino alla presa di
corrente.

Driver della stampante

Questo driver della stampante ¢ stato realizzato

per la realizzazione di quadri tramite trasmissio-
ne dei dati originali dal computer.

Il driver della stampante & contenuto nel
CD-ROM in dotazione. Quando si realizza un
quadro principale per la prima volta, & necessa-
rio installare il driver della stampante.

Precauzioni relative al
collegamento con un
computer

® Prima di utilizzare la macchina, assicurar-
si di installare il driver della stampante dal
CD-ROM in dotazione.

@ 'mportant

Non collegare la macchina con il computer
prima di installare il driver della stampante.

® Questa macchina deve essere collegata con

| Precauzioni per l'uso
~ Utilizzo

La macchina & un dispositivo di precisione.
Non collocare oggetti pesanti sulla macchina,
non urtarla o applicare una forza eccessiva
su di essa.

Non inserire le dita o le mani nella testina ter-
mica e in altre parti mobili.

Non spostare il quadro serigrafico con le
mani. Utilizzare la modalita Impostazione
personalizzata per spostare il quadro seri-
grafico al centro.

Non spegnere la macchina, né staccare la
spina durante il funzionamento.

Mentre la macchina & in funzione, non spo-
stare il quadro e non spostare la macchina.

Non aprire il quadro serigrafico durante il fun-
zionamento.

La macchina contiene componenti di preci-
sione e parti in movimento. Eseguire solo le
procedure specificamente descritte nella pre-
sente guida.

Pulire la macchina frequentemente. Se del
materiale estraneo € presente su un quadro,
la testina termica potrebbe subire danni. Non
utilizzare solventi organici altamente solubi-
li come diluenti e benzina per la pulizia. Se
vengono utilizzati, il rivestimento potrebbe
staccarsi e si potrebbero verificare dei guasti.
Per la pulizia, utilizzare un detergente neutro.
Per la macchina, utilizzare RISO Digital
Screen Master specificato e RISO DIGITAL
SCREEN QS MASTER. Se vengono utilizzati
altri quadri, la qualita non & garantita.

Quadro principale » P. 78
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un computer tramite un cavo USB disponibi-
le in commercio (inferiore a 3 m, compatibile
con Hi-Speed USB).

® |a tensione massima consentita per il con-

nettore USB, in ingresso e in uscita, & pari
a5V



Appendix

Conservazione del quadro I Materiali da non stampare

prinCipale Non utilizzare la macchina in alcun modo che

possa violare le leggi o i diritti di riproduzione,

Non conservare i materiali di consumo negliam- nemmeno per eseguire copie a fini personali.

bienti sotto elencati. Per ulteriori dettagli, consultare le autorita locali.
o Ambienti direttamente In generale, usare discrezione e buon senso.

esposti alla luce solare di-
retta, come ad esempio
vicino ad una finestra (se
necessario, munire di tende
le finestre)

* Ambienti soggetti a improvvisi sbalzi di
temperatura

* Ambienti estremamente caldi e umidi oppu-
re freddi e secchi
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Caratteristiche di questa macchina

Questa macchina & un creatore di schermi digitali progettato esclusivamente per RISO Digital Screen Masters. Fissare uno schermo alla corice dello schermo
e impostarlo sulla macchina per eseguire lo screen making (creazione dello schermo). Questa guida descrive la procedura fino al punto “3. Screen making'.

I Processo da Screen making a Stampa

— Installare il “Driver della stampante W Trasmettere i dati originali.

() RISO GOCCOPRO” sul proprio com- ' (0)) |

O puter. Q :

> ) Print!
«Q

=

Q 3

o, O 972‘ | |

g 5' :m II 1> 111 A r I|Q
(¢ I N (o)

5 E= | '_"JU_“_“_H [ Invio dei dati originali:

N Per Windows > P. 42

Q' Procedura di installazione: Per Mac OS » P. 50

D Per Windows P> P. 35 :

Per Mac OS - P. 38 Lo screen making ha inizio.

Impostare la cornice dello schermo sulla macchina.

Lo screen making & terminato.
Impostazioni della cornice dello schermo B> P. 30

Collegare il dispositivo al computer trami-
te un cavo USB, quindi accendere l'inter-

ruttore di alimentazione della macchina.

Stampa con inchiostro adatto al mate-
riale e all'uso previsto.

Bunfew usaios ojop auoizesedaid 'z

edwels 'y

Connessione del cavo e fonte di alimentazione
» P 32
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I Punti di controllo del funzionamento

¢ Registrazione delle cimensioni della comice dello schermo

Impostare in anticipo la cornice dello schermo da utilizzare.

Frame
Width: 50 ] [ah o)

[23.23 - 25.00
Length: 36.00 % inch

[12.20 - 36.00]
Thickness: ~ 1.57 | inch

[0.79-1.77)

iy

Import ( Export ]

Dimensioni della cornice dello schermo B> P. 25

Registrazione della dimensione della cornice
dello schermo (Windows) B> P. 43

¢ Impostazione del driver della stampante

Il tipo di screening pud essere specificato in
base allimmagine da trasferire, al materiale sul
quale stampare e all'inchiostro da utilizzare.

e
s [ ]
Abcd St st .m
E} ....... — - :
ks e 200m.
= e
Abcd
o —
o
pmmere
------ o
e )
=

Dﬂ Registrazione delle dimensioni della cornice
dello schermo (Windows) » P. 46

Registrazione I'area dellimmagine
(Mac OS) » P. 51

Impostazione del processo di screen making:
Per Windows »> P. 46
Per Mac OS » P. 54

Impostazione del tipo di screening:
Per Windows P P. 48
Per Mac OS » P. 55

€ Anteprima

E possibile controllare un’anteprima di come limmagine
verra trasferita sullo schermo su [Anteprima] del driver
della stampante prima di eseguire lo screen making.

* Limmagine & contenuta allinterno dell'area immagine?
* Lorientamento dellimmagine & corretto?

Dimensioni della cornice dello schermo (larghezza della comice)

=

Qo

§ Superiore

= -

o} Marglrl 1

[l

N

N

(]

=

f=2)

o

E}

o

£

FMll Anteri  Posteriore
o E
K] )
=]

D ©
g ©
S 28
= QE
[} Q.
= )
5

E !
(<5}

E

(=)

Spessore della cornice <>

Ulteriori dettagli sularea immagine e sullorientamen-
to dellimmagine sono descritti altrove in questa guida.

Informazioni sullo screen making B> P. 25

| Funzionalita delia macchina

La macchina consente la riproduzione accurata di testi e gra-
dazioni con un’alta precisione tramite perforazione ad alta riso-
luzione a 600 dpi (densita perforazione 1200 dpi) x 1200 dpi.

(Immagine)

AL AA

=

600 dpi 1200 dpi

Potrebbe essere necessario una lavorazione speciale, a se-
conda del tipo di supporto.
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GOCCOPRO QS2536

Metodo screen
making

Screen making digitale ad alta velocita

Durata dello screen
making

Circa 200 sec (dimensioni dell’area immagine A2 (420 mm x 594 mm))

Dimensioni dell’area
immagine

Minimo: 10 mm (larghezza) x 10 mm (lunghezza)
Massimo: 457 mm (larghezza) x 759 mm (lunghezza) (con uno spessore della cornice di 20 mm)
455 mm (larghezza) x 734 mm (lunghezza) (con uno spessore della cornice di 45 mm)

Risoluzione

600 dpi (densita di perforazione: 1200 dpi) x 1200 dpi

Pannello di controllo

Pulsante in resina/display a 7 segmenti

Posizione di avvio
scrittura

90 + 2 mm dal lato superiore

Margine

45 mm o piu sul lato inferiore
45 mm sul lato anteriore, 45 mm o piu sul lato posteriore

Precisione della
posizione dello
screen making

+ 0.5 mm o meno (precisione della posizione quando si effettuano piu stampe)

Modalita di
impostazione
personalizzata

Segnale acustico/Contatore dello screen master (n. di stampe)/Espansione/riduzione
dellimmagine/Stampadiprova(controllo, grigliaclineaneracentrale)/Commutazioneauto-
maticadelloscreenmaking/Centraturadelloscreenmaking/Visualizzazione delleinforma-
zionisullaversione/Controllodel sensore delloscreenmaster/Controllo del sensore dipres-
sione dello screen master/Controllo dell'interruttore di impostazione dello screen master/
Controllo del sensore cornice inferiore/Termistore/Controllo della tensione TPH (fronte e
retro)/Variabili energia dello screen making

Dimensioni della
cornice
(dimensioni esterne)

Minimo: 590 mm (larghezza) x 310 mm (lunghezza) (con uno spessore della cornice di 30 mm)
Massimo: 635 mm (larghezza) x 914 mm (lunghezza)

Spessore della
cornice

Da 20 mm a 45 mm

Capacita di memoria

128 MB

Sorgente di
alimentazione

CA 100-240V,50-60Hz, 3,6-1,4A

Consumo di energia

Massimo: 300 W
In standby: 50 W 0 meno

Dimensioni Durante I'uso: 1215 mm (L) x 800 mm (P) x 410 mm (A)
Spazio necessario | 1230 mm (L) x 800 mm (P) x 480 mm (A)
Peso Circa 71 kg
Informazionisulla |Uso interno, grado di inquinamento 2%,
sicurezza Ad altitudini di 2000 m o inferiori
Driver CD-ROM
Accessori Driver EULA

Scheda di tutela della privacy

*Il grado di inquinamento dell’ambiente di utilizzo dovuto a sporcizia e polvere nell’aria. |l grado “2” corri-
sponde a un ambiente interno generale.

® Nota

* Notare che a causa di migliorie e modifiche al macchinario, alcune immagini e spiegazioni contenute
in questa guida potrebbero non corrispondere al vostro macchinario.

* Le specifiche sono soggette a modifiche senza preavviso.

¢ Notare che RISO

non sara ritenuta responsabile per qualsiasi problema derivante dall’'uso di questa

guida o del macchinario.
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Avviso per gli Stati
membri dell'Unione Europea

RISO, I'ambiente e la direttiva sui rifiuti di apparecchiature
elettriche ed elettroniche (direttiva RAEE)

Che cos'e la direttiva RAEE?

La direttiva RAEE mira alla riduzione dei rifiuti € ad assicurare il riciclo delle
apparecchiature elettriche ed elettroniche al termine del loro ciclo di vita.

hi¢

Che cosa significa il simbolo del bidone dei rifiuti barrato?

Il simbolo del bidone dei rifiuti barrato indica che il prodotto deve essere smaltito
separatamente rispetto ai normali rifiuti.

Per informazioni sullo smaltimento contattare il servizio di assistenza tecnica RISO.

Che cosa significa la barretta nera?
La barretta nera sotto al bidone dei rifiuti indica che il prodotto e stato immesso sul
mercato dopo il 13 agosto 2005.

Come fare per ottenere ulteriori informazioni sulla
direttiva RAEE?

Per ottenere ulteriori informazioni contattare il servizio di assistenza tecnica
RISO piu vicino.
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( Please contact the following for supplies and service:
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